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Introduction

Introduction

The complex feature set of ARCHICAD's Calculate function interacts with the project database to
calculate the number of elements in a project, their spatial disposition and the quantity of element
components. Specialized menu commands allow you to perform various calculations (quantity
takeoffs, inventories, pricing, schedules). The extracted information can be searched, presented in
customized layouts and exported easily to other applications.

The ARCHICAD Calculation Guide is a compact manual aimed at experienced users that explains the
features used to generate reports about your project. The Calculation Guide Appendix presents two
step-by-step calculation examples. (If you are new to the Calculation function, begin by reading a
brief overview: “Calculation” in the Documentation chapter of the ARCHICAD Help.)

Note: The Calculation functionality is considered legacy, and is unlikely to support new
developments in ARCHICAD.

e The Stair and Railing Tools (as of version 21) are not supported.

e Segmented and tapered Beams and Columns (available as of version 23) are not supported.
Single-segment Beams and Columns are supported as in previous versions.

To list the new element types, use the Interactive Schedule.
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Calculation Commands

Calculation Commands

The Calculation function is a tool aimed primarily at advanced users. Many of the commands
referenced in this section are not visible in ARCHICAD’s default work environment profiles. To add
these commands to your work environment, use Options > Work Environment > Menus to add the
following commands to an existing menu (e.g. Document > Schedules & Lists):

e Set up List Schemes

e Edit Database

e New Properties

e Edit Properties

e Last Selection’s Properties

e Link Properties to Criteria

Listing Commands

The Element Lists, Component Lists and Zone Lists commands generate lists of different formats
and complexity for the entire project or a particular element selection based on the instructions
defined in the Setup List Schemes dialog box.

To create the desired List, choose one of the predefined List Schemes from the submenus.
Document  Options  Teamwork  Window  Test LHS  Help

i 3
Documenting Tools - ﬁ ‘ ‘ % =

% Change Manager

Spell Checker 4
) = .
! Document Extras y [biect Inventan] x [Drawlng]
3 Viewpoint Name Thickness/Size Height
Set Model View 4
or 340 0.85
Layers »
Renovation 4
Graphic Overrides 4
Pen Sets 4
Schedules 4
. e !
%_z Floer Plan Cut Plane... Elements Lists =| Basic
ompopeniiet: i’ My Object Inventory
i 13 .
3D Document 3 ZonellEl Objects total
Creative Imaging » German Calculation Tool 4 Default
| Schedules and Lists General Elemnent List
Project Indexes 3 Apartment Stamp b Window schedule Type 1

See the detailed explanation of the list types in List Types.

Selection and the Listing Commands

When you choose a listing command while elements are selected in the project, there may be a
conflict between the listing command’s criteria and the selection. (For instance, if you choose a
Window schedule when the current selection also contains Walls and Doors.)

In Options > Work Environment > Model Rebuild Options, the Selected Elements to be Calculated
pop-up menu offers three options for managing this situation.
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Calculation Commands

* MODEL REBUILD OPTIONS

Background Updating:
(® Enabled
Automatically updates inactive model views when computer is idle.

O Enabled when device is plugged in
Power save mode recommended for mobile devices, Automatically suspends
background updating when device is not connected to external power.

() Disabled

Auto-rebuild Model View Control:

Update Auto-rebuild Model viewpoints continuously

ARCHICAD will continuously rebuild Sections/Elevations/Interior Elevations of
Auto-rebuild Model type to reflect your edits while you work in the viewpoint,

30 Window Rebuild Controls:
[] Auto-rebuild 30 Window when activated
|:| 3D Settings changes bring 30 Window to front
Keep zoomed detail on Rebuild

Section Window Rebuild Control:
Keep zoomed detail on Rebuild from Model

30 and Calculation Process Check Controls:
Show Progress Window
|:| Interrupt with error messages
Write Report ]
Erief Report Full Report

Selected Elements to be Calculated: Show Alert ~

List All
Use Filters

If you choose the List All option, all the selected elements will be calculated in the list, even
though they do not correspond to the filtering criteria.

If you choose the Use Filters option, the filters defined for the list template will be applied to the
selected elements; elements that do not correspond to these criteria will be ignored.

If you choose the Show Alert option, a warning of conflict will appear. You will then be able to
choose between the two options described above.

List Schemes and Output Reports

The sorting and analyzing of data, the calculation of required results and the formatting of reports
are all done according to the selected List Scheme. List Schemes are predefined sets of instructions
on how ARCHICAD should present the required results. List Scheme formats can be of two types:

Plain Text reports display calculation results in editable tabulated text format. The reports
appear in text windows and can be saved as spreadsheets, text files or HTML files.

Graphic outputs allow for both alphanumeric and image information, including element symbol
drawings, logos and other bitmaps. Graphic output reports can be saved as RTF List files or
ARCHICAD Project files. It is also possible to copy all or part of these lists into any of the
Drawings.

Although the content of each language version is different, some factory default list schemes are
available even if ARCHICAD is running without an active Library.

Graphic Schemes based on predefined templates can be configured using the Format Assistant or
Format Wizard.

See The Setup List Schemes Dialog Box and Using the Format Wizard/Format Assistant.
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List Types

List Types

ARCHICAD can generate three types of calculation reports: Element Lists, Component Lists and Zone

Lists.

Note: Add-On commands can also generate other list types.

Element Lists

Element Lists are best used for creating schedules and inventories, and to display the parameters of

construction elements in a project.

| = TEATFIELD 1 77
FTERTFIELD 2 777
/ EFTEATFIELD 3 ==
L = TEXTFIELD 4 ===
General element list 271
Width 1
Element Story Layer Hame User ID Library part Thickness Height Surface Volumes
WALL
0. Story Exterior walls Wrall-013 0.20m 244m 19.07 m® 38T m®
0. Story Exterior walls Wall-014 0.20m 244m 9.81 m* 1.99 m*
0. Story Exterior walls Wall-015 0.20m 244m 16.66 m* 338 m*
0. Story Exterior walls Wrall-016 0.20m 244m 1837 m® 3TIm®
0. Story Exterior walls Wall-017 0.20m 244m 11.34 m= 230m*
0. Story Exterior walls VWall-018 0.20m 244m 1229 m* 248 m*
0. Story Exterior walls Wrall-0149 0.20m 244m 1.94 m® 0.33m*
0. Story Exterior walls Wall-020 0.20m 244m 1028 m= 1.99 m=
0. Story Exterior walls Wall-021 0.20m 244m I m? 0.588 m*
0. Story Exterior walls Wrall-022 0.20m 244m 886 m° 1.73m*
WAL 0. Story total 1M11.91 m? 2240 m?
WALL total for all stories 1M.91m? 2240 m°
COLUMM
0. Story Columns coL-0m 0.41m 244m 297 m* 0.23m*
page 1
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List Types

i

.

s TENTFIELD 1 22
s TENTFIELD 2 2424
s TENTFIELD 3 22
satn TENTFIELD 4 #tot

Window Schedule Si31me9
‘Width: 0.90 m
W BottomHung Height: 060 m 4 pieces
User ID ind-065
Opening orientation 1]
aterial Pine
D Frame thickness 0.06
Frame wicth 0oy m
Width: 0.60 m
W1 Casement 1 pieces
Height: 1.20 m
Uzer D WWinc-071
Opening orientation 1]
Materizl Pine
|D| Frame thickness 006
Frame wicth 007 m
‘Width: 0.90 m
W1 Casement 1 pieces
Height: 1.20 m
Uzer D Wind-063
Opening orientation 1]
Materizl Fine
D Frame thickness 0.0s
Frame wicth 0oy m
page 1

To generate Element Lists, ARCHICAD filters the project or the selection set for construction
elements according to the configuration of the selected List Scheme. Elements matching the filter
settings will be listed together with element Parameters, Components and Descriptors, if so defined
in the List Scheme.

The following table lists different element types, their surfaces, and what Volume means for the
different element types.

Element Surface Surface Surface | Surface | Surface Volume
Wall Ref! Other! Edge2 Total volume
Column Core Core
Beam Top Bottom Left3 Right3 End Total volume
Slab Top Bottom Edge Total volume
Roof Top Bottom Edge Total volume

ARCHICAD Calculation Guide




List Types

Element Surface Surface Surface | Surface | Surface Volume
Mesh Top Bottom Edge Total volume
Zone Area Total volume
Object Total Total volume
Door/ Surface of Total volume of
Window library part library part elements
elements
Notes:
1

including surfaces around openings with reveals and along reveal depth. “ref” stands for the
reference line side of the wall and “other” for the side opposite the reference side of the wall.

all edges (top, bottom, both sides), including the edges of openings, except for some special
edges of openings with reveals.

left and right side of the beam as defined by its orientation; left and right may be different
when the beam is connected to a wall at a non-perpendicular angle.

Component Lists

Component Lists are generated when bills of materials, quantity takeoffs or price lists are required.
These reports typically sum up and display component type properties; however, certain element
parameters can also be listed.

- A e TERTFIELD 1 =
= TESTFIELD 2 ==
/ FTERTFIELD 3 777
L s TEXTFIELD 4+
Component List by keys 27
Key
CodeMame | Code Hame Datahase Oty. Unit Ref. Oty. Ref. Unit Quantity
004 Masonry
100 carmmon hrick 24%11 .57 1 cm 383.200 pieces 3.386 m* 1,287.510
100 common brick 24%11.5%7.1 cm 383.200 pieces 5.0448 m* 1,833.271
100 common brick 24711 .5%7.1 tm 383.200 pieces 1.992 m* JB3.507
100 common hrick 24711.5%7 1 cm 383.200 pieces 3.732 m* 1,430.132
Total common brick 24*11.5*7.1 cm 5,425.00 pieces
1m mortar 0.169 ma3 1.992 m* 0.337
1m martar 0.169 m3 3.386 e 0.572
1m maortar 0.169 m3 5.045 m* 0.843
1m mortar 0.169 ma3 3732 m* 0.631
Total mortar 3.00 m3
102 plaster 0.030 m3 19.611 me 0.588
102 plaster 0.030 ma3 33327 me 1.000
102 plaster 0.030 m3 36.733 me 1.102
102 plaster 0.030 m3 49 656 me 1.4490
FPage 1
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List Types

Ej untitled / Components 10l =|
| Element type | Fill Name / Composite Name | Descriptor 3hort Text | Component Key Name | ;I
[ [ [ | -
14 | WALL | common brick | -common brick masonry with 12.5 mm horizontal and | / |
14 | WALL | common brick |/ | Masonry |
14 | WALL | common brick |/ | Masonry |
14 | WALL | common brick |/ | Masonry |
1 | SLAE | structural concrete | * Reinforced concrete slab * (s |
1 | SLAE | structural concrete (s | Concrete |
1 | SLAB | structural concrete |/ | Thermal & moisture protection |
4 | ROOF | flat roof | * Tiletwood joist and rafters + |/ |
4 | ROOF | flat roof (s | Finishes |
4 | ROOF | flat roof (s | Finishes |
4 | ROOF | flat roof (s | Finishes |
4 | ROOF | flat roof |/ | Thermal & moisture protection |
4 | ROOF | flat roof (s | Wood-Plastic |
4 | ROOF | flat roof (s | Wood-Plastic |
| | | | I- -
<] [z

Zone Lists

Zone Lists are generally used to create room schedules and finish schedules. Zone Lists can include
parameters of Zones and related construction elements. When related construction items are listed,
the report is in fact an Element List where the range of calculated elements is limited by the Zones

they belong to.

Ej untitled / Components 10l =|
| Element type | Fill Name / Composite Name | Descriptor 3hort Text | Component Key Name | ;I
[ [ [ | -
14 | WALL | common brick | -common brick masonry with 12.5 mm horizontal and | / |
14 | WALL | common brick |/ | Masonry |
14 | WALL | common brick |/ | Masonry |
14 | WALL | common brick |/ | Masonry |
1 | SLAE | structural concrete | * Reinforced concrete slab * (s |
1 | SLAE | structural concrete (s | Concrete |
1 | SLAB | structural concrete |/ | Thermal & moisture protection |
4 | ROOF | flat roof | * Tiletwood joist and rafters + |/ |
4 | ROOF | flat roof (s | Finishes |
4 | ROOF | flat roof (s | Finishes |
4 | ROOF | flat roof (s | Finishes |
4 | ROOF | flat roof |/ | Thermal & moisture protection |
4 | ROOF | flat roof (s | Wood-Plastic |
4 | ROOF | flat roof (s | Wood-Plastic |
| | | | I- -
<] [z
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Structure of the Calculation Databases

Structure of the Calculation Databases

Most of the information that is needed by ARCHICAD to create complex reports comes from
Property Databases in active Libraries. You can use, extend, modify and update factory default
Database(s) that come with ARCHICAD, and you can also set up multiple Databases that match your
specific needs. Databases can include Components, Descriptors and Units organized in logical
groups called Keys. Databases can be edited - including the creation of new Databases, Keys,
Components and Descriptors - using the Calculation commands.

See also Calculation Commands.
Databases are sets of files placed in List Templates/Property Data folder of the ARCHICAD Library.

MName

Properties 19
Properties Composite 19
(= ArchiCAD_Library.lis
ArchiCAD_Library_COMP bt
ArchiCAD_Library_CRIT.lic
ArchiCAD_Library_DESC bt
ArchiCAD_Library_KEY.bt
ArchiCAD_Library_UNIT bt
MASTER_GDL_ArchiCAD_Library.gd

The built-in calculation database can be accessed through the Edit Database command.

Edit Database =] 2 3]
Databases in Active Libraries:
Default Set Duplicate Delete

Kostenermittiung

ArchiCAD_Library EHiEatalia g

Mame: WrchiCAD_Library

Note: The database also contains the units that elements refer to. (See below.)

See also Editing the Calculation Database.

Keys

[0 Sitewaik
O-rr Concrete
O-rr hd asonny
O-rr hetals

[ o] Wipod-Flastic

Data items in Databases are arranged in a hierarchical system categorized by Keys. A Key includes a
group of Components and Descriptors that are logically grouped, typically following a country’s
takeoff standards. Properties can, for instance, be grouped by type of structure, e.g., Walls,
Columns, Roofs; by material, e.g., Concrete, Timber, Steel; or type of work, e.g., Foundation,
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Structure of the Calculation Databases

Electrical, Furnishing. Cross-references are not possible, which means that the same Property item
cannot be grouped in multiple Keys unless you duplicate it for each Key.

Every Key has a name and a code that are both alphanumeric definitions. A database’s Keys are
arranged in alphabetical order by their codes. Keys can have a hierarchy among themselves which is
also controlled by the code. The Code is the identifier whose name can be descriptive.

Example:
Edit Database =] = [
Databases in Active Libraries:
w ArchiCAD_Library ~ Duplicate Delete
oew| General
oew| Sitework EUIEEEY:

|| Concrete

Database: WrchiCAD_Library
& Components
| Descriptors Code: |DD3 |
| Masonry
Mame: |Concrete |
oew| Metals

oew| Wood-Plastic

A Key named ‘Concrete’ is created. Its Code is ‘003’.

Edit Database =] = |3
Databases in Active Libraries:

G| General ~ Duplicate Delete

o] Sitework
~ [ Concrete EUILEST:
@ Components
e Database: WrehiCAD_Library
[ Descriptors

fimw| Precast Concrete Code: |DD3.DD1 |

| Masonry
Mame: |Precast Concrete| |

ol Metals

o Wood-Plastic

Another Key named ‘Precast Concrete’ is created. Its Code is ‘003.001’. Because of this format, it
becomes the sub-key of the Key ‘Concrete’

Edit Database =] = [
Databases in Active Libraries:
w ArchiCAD_Library ~ Duplicate Delete
oew| General
oew| Sitework EUIEEEY:

W || Concrete
Database: WrchiCAD_Library
& Components
] Descriptors Code: [003.001.001 |

|| Precast Concrete

Mame: |PrecastWaII |

o-v| Precast Wall

| Masonry

An additional Key named ‘Precast Wall’ is created. Its Code is ‘003.001.001". Because of this format,
it becomes the sub-key of the sub-key ‘Precast Concrete’.

This way up to four levels of hierarchical Keys and sub-keys may be created.

ARCHICAD Calculation Guide 13



Structure of the Calculation Databases

Components

Edit Database

Databases in Active Libraries:

oew| General
oew| Sitework

|| Concrete

[ Components

concrete

concrete

lightweight concrete
structural concrete
lightweight concrete

concrete block 20%24*49 cm

precast concrete plank

Components can either be the material ingredients (steel, concrete, etc.) of a structure, or anything
(price, man hours, etc.) that can be measured in proportion to elements of the structure type. Each
Component has a name, a code, a quantity definition, a unit and a reference to its proportion to
related construction elements.
e Code: can be any alphanumeric string (e.g. ‘1143’, ‘Wall-012’, ‘JKG-ft’, ‘345fdsr’ etc.)
e Name: text string identifying the Component for the user (e.g. ‘gravel’)
e Quantity: a numeral value (e.g ‘412.5’)

¢ Unit: any of the Units defined under ‘Unit’ within the same Database (e.g. ‘kg’, ‘m2’, ‘Euro’, ‘S’
etc.) — selectable from pop-up menu.

e Reference Quantity: predefined set of values. The component will be calculated proportionally
to the selected Reference Quantity.

e [tem: the component will be calculated per piece of the construction element
e For other reference units, see the below table and its explanation:

Referenced Length Surface A | Surface B Surface C Volume
element
Wall (Ref+other)/2 Ref Other Ref+other Total vol.
Column Height Around Around Around veneer | Core+veneer
veneer veneer

Beam (Left+right)/2 Left Right Total Total vol.

Slab Perimeter Top Bottom Top+bottom Total vol.

Roof Perimeter Top Bottom Top+bottom Total vol.

Mesh Perimeter Top Bottom Total Total vol.

Zone Perimeter Area Area Area Total vol.

Object Length along x 0 0 Total Total vol.
axis (=A)

Opening Width of the Width* Width* Surface of the | Total volume of
opening height height elements in the | the elements in

library part the lib. part

¢ Abbreviations:

ref: this means the reference line side of a wall

ARCHICAD Calculation Guide
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Structure of the Calculation Databases

other: this means the opposite side of a wall
left: this means the left side of a beam taking into account its orientation
right: this means the right side of a beam taking into account its orientation

e Meanings:
components proportional with column length: Height of the column is taken instead of 0
components proportional with beam length: (left+right)/2 is taken instead of O
components proportional with object length: the parameter A is taken instead of 0
components proportional with column surfaces: the surface around the core is omitted, only the
surface around the veneer is taken. If there is no veneer, the core surface is taken.

Notes:

e the left and the right side length of a beam may be different when it is connected to a wall in
a non-perpendicular angle.

e some values are intentionally different from the appropriate element list values, as the
associated components are usually calculated based on different surfaces. For example you
may want to calculate the painted surface of a wall. In this case you are not interested of the
edge surface but the sum of the reference and the opposite side surface of the wall.

e Components can reside in Databases (global) or locally in Property Objects. Library Part type
construction elements (Objects, Lamps, Windows and Doors) can also have locally defined
(i.e., object-specific) Properties: however, these are only available for the Library Part they
were defined in, and cannot be linked to other elements. Property Objects can be created
and edited using the File > Libraries and Objects > Open Object, then editing in the Property
Script window, or by using the appropriate Calculation commands: New Properties and Edit
Properties.

For more information, see Property Objects.

Descriptors

Edit Database
Databases in Active Libraries:
[0 Masonry ~
& Components
~ [ Descriptors
-common brick masonry with 12,5 mm |
-.f-ace brick”wii.:h 1.2.5. mm .hor.iz;m.tal am
-.raasonry EIIoc.k wit.ﬁ 10 rr.lmjoints. h.o}i;
-gg.-'pgum b-l.ock.s \c\.r.ii:h 2 mm gyps.umjoi.r
-common brick masonry with 12,5 mm |
-:f:ace brick: W|th 1.2._5_. mm :hor.iz_;m.t_al_anu

-face brick masonry with 12.5 mm haoriz

EddEdEddE€

-laid flat in 17.5 mm mortar hed e

< >

Descriptors are text elements related to structure types, e.g., finishing, security, shipping, assembly
or handling information. Descriptors are simply displayed in reports: they are not used in
calculations and are not linked to components or element parameters. Each Descriptor has a name
(also called short text), a code and the full description (long text).

Just like Components, Descriptors can reside in Databases (global) or locally in Property Objects.

ARCHICAD Calculation Guide 15



Structure of the Calculation Databases

Units

Edit Database
Databases in Active Libraries:
| Special Construction
oew| Mechanical
| Untitled Key
| Thermal & moisture protection
oew| Dimensional Lumber
=3 Units
= m
= m2
= m3

0 pieces

v

Every Database has a special item group for the Units used in calculations. The Units set is on the
same hierarchy level as the primary Keys of the Database. An unlimited type of Units can be defined

for every Database.

ARCHICAD Calculation Guide
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Editing the Calculation Database

Editing the Calculation Database

Choose the Edit Database command. The resulting dialog box contains the controls to create,
customize, modify and delete the elements of the database(s) ARCHICAD uses to process your

project information for reports.

Edit Database

Databases in Active Libraries:
o-w| Concrete
| Masonry
oew| Metals

oew| Wood-Plastic

tew| Doors-Windows
oew| Finishes

| Specialties

| Equipment

| Furnishings

| Special Construction

| Thermal & moisture protection

b Details of Database items on the same level

=R N ==
~ Duplicate Delete
Edit Key:

Database: WrchiCAD_Library

Code: [003 |

Mame: |Concrete |

The information elements are arranged in hierarchical order. You can view the contents of a
database in the left-hand side of the dialog box.

The right-hand side of the dialog box changes according to the item selected on the left (see specific

sections for details).

At the bottom of the dialog box, use the “Details of Database items on the same level” section to
view the details of all the items that are at the same level as the one selected on top, that is, all
databases, all keys in a database, all components under the same key, etc.

The default ARCHICAD database contains numerous preset Keys, Components and Descriptors, as
well as the Unit set, listed at the very bottom.

Edit Database
Databases in Active Libraries:
| Equipment ~
| Furnishings
| Special Construction
oew| Mechanical
| Untitled Key

oew| Dimensional Lumber

=] Units
= m
= m2

= m3

0 pieces

You can remove selected databases or database items with the Delete button at top, or create new
databases or database items with the Create pop-up list at top right.

Important: When you leave this dialog box and click Yes in the Save Changes dialog box,
ARCHICAD overwrites the corresponding database files with your changes.

ARCHICAD Calculation Guide
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Editing the Calculation Database

The database files can be saved to the List Templates subfolder of the ARCHICAD Library folder.
When creating a new database, a set of new files is generated using the name of the new database.

MName

Properties 19
Properties Composite 19

(2 ArchiCAD_Library.lis
ArchiCAD_Library_COMP bt
ArchiCAD_Library_CRIT lic
ArchiCAD_Library_DESC. bt
ArchiCAD_Library_KEY bt
ArchiCAD_Library_UMNIT et

[ MASTER_GDL_ArchiCAD_Library.gd

MName

ey
&3

Properties 20

Properties Composite 20
ArchiCAD_Library.lis
ArchiCAD_Library_COMP bt
ArchiCAD_Library_CRIT lic
ArchiCAD_Library_DESC. bt
ArchiCAD_Library_KEY bt
ArchiCAD_Library_UMNIT et

@ MASTER_GDL_ArchiCAD_Library.gdl
E MASTER_GDLMewDatabase.gdl

ey
&3

MNewDatabase.lis
MewDatabase COMP bt
MewDatabase_CRIT lic
MewDatabase DESC.tet
MewDatabase_KEY .t
MewDatabase UNIT. bt

In addition to the _KEY (keys), _COMP (components), _DESC (descriptors), _UNIT (units) and _CRIT
(criteria assignment) files, a new SCHEME (list scheme) and _MASTER_GDL files are also created.

Editing Keys

Highlight the name of a key in the database to edit its Code and Name in the text fields in the right-

hand side of the dialog box.

Edit Database =] = [
Databases in Active Libraries:
w [§] archicaD_Library ~ Duplicate Delete
General
Sitework EdiHEEY
Concrete
Database: WrchiCAD_Library
Masonry
Metals Code: [o01 |
‘Wood-Plastic
Mame: |Genera| |
Thermal & moisture protection
Doors-Windows
Finishes
Specialties
[ S e
w Details of Database items on the same level
Code MName
001 General -
002 Sitework
003 Concrete
004 Masonry
005 Metals
006 ‘Wood-Plastic
o007 Thermal & moisture protection
008 Doors-Windows W

The order and hierarchy of keys is defined using the codes: subordinate keys appear at lower levels,
e.g., together with primary components and descriptors of a key. The key code can include any

ARCHICAD Calculation Guide
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Editing the Calculation Database

character, but when establishing a hierarchy, define keys as you would an IP address, in other
words, a maximum of four sets of three digits separated by dots, e.g., “100.200.300.124".

Separator dots in the key code help define a hierarchy.

Keys must be unique within a database.

Edit Database =] = [
Databases in Active Libraries:

Kostenermittiung

ArchiCAD._Library Edit Key:
hd MewDatabase
Database: MNewDatabase
M= Coverings
v B Code: [001.001.001.001 |
 [o==| Wall Painting . |Emu|sion |

Emulsion

Example of fourth level sub-key

Editing Units

Highlight the name of a selected unit to edit its attributes using the controls in the right-hand side
of the dialog box.

Edit Database =] = [
Databases in Active Libraries:

Furnishings - Duplicate Delete

Special Construction

Mechanical EdHEnE
Untitled Key Database: WrchiCAD_Library
Thermal & moisture protection
M :
Dimensional Lumber ame @
v B3 Units [ sustify left
f— |:| Plus sign
|:| Space before positive values [if no Plus sign)
= m2 -
|:| Don't display Zero wholes
= m3 Display Zero inches
0 pieces
[ T ¥ Width: Decimals: 3 0

Conversion Unit: none 3
w Details of Database items on the same level

Space before positive values [if no Plus sign)

Plus sign Don't display Zero wholes
Justify left Display Zero inches
MName Width Decimal/Fractio Conversion Uni
- O 0O 0O 0O 0 11 3 .
m2 Oo0ooao 1 3 -
m3 Oo0ooao 1 3
pieces Ooooag 11 3

The top (uneditable) row displays the name of the database the selected unit belongs to. Edit the
name of the unit in the text field provided.
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The five formatting options in the center of the window control how the units will be displayed in
the plain text list. Please bear in mind that Graphic Templates can override these settings.

1.

Check the 'Justify Left' checkbox for the calculated value using the unit to be justified to the left,
causing the remaining characters defined by 'Width' padded with SPACEs. As default, all Units
are right-justified and character places on the left are padded with SPACEs.

Checking the 'Plus Sign' checkbox inserts a '+' sign as the first character of the values string,
allowing one character less in the number value.

Checking the 'Space before positive values (if no Plus sign)' checkbox places a SPACE character as
the first character, if no plus sign is specified to be placed, making it possible for all values to
align well to the left.

Checking the 'Don't display Zero wholes' checkbox will not display the Zero whole and the
decimal separator, in case the absolute of the displayed value is between 0 and 1 inch. This
applies to values displayed in decimal format. Such can be the case with width and height of
Windows and Doors, for example.

Check the 'Display Zero inches' checkbox for Zero to be displayed when the absolute of the
displayed value is between 0 and 1. This applies to values displayed in Imperial format.

In the Width text field, set the number of digits to be used when displaying the unit. Note that
the Width value cannot be less than three.

oew| Mechanical

M 3
o Untitled Key ame m
| Thermal & moisture protection [ ustify left

DPIus sign

oew| Dimensional Lumber
|:| Space before positive values [if no Plus sign)

|:| Don't display Zero wholes
Display Zero inches

=] Units
= m

= m2

N ¥ Width: Decimals: 0

Conversion Unit: none 3

b Details of Database items on the same level

Choose the desired number of decimals places to be displayed in reports from the Decimals
pop-up list in the bottom right corner.

Use the Conversion Unit pop-up at the bottom of the dialog box if the selected database unit is
different from the one chosen in the Options > Project Preferences > Calculation Units & Rules
dialog box. Choose “none” from the pop-up list if using this option is not appropriate. Selecting
the proper conversion units decreases calculation errors when database units and calculation
units are different.

Note: ARCHICAD calculations are performed according to the settings of the Calculation Units
and Rules dialog box (Options > Project Preferences > Calculation Units & Rules) except when
instructions in Graphic Templates override the settings.
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.; Project Preferences ? 4
| Calculation Units & Rules v| << Previous Mext > >
A2, Length Unit: | meter w
Extra Accuracy: Off ~ 012
£7 Area Unit: | square meter b
Extra Accuracy: Off ~ 012
@ Volume Unit: | cubic meter b
Extra Accuracy: Off ~ 012
A‘x Angle Unit: | decimal degrees b
Decimals: o

Mote: Calculations using Graphic Templates will override these settings

Conditional Parameters Calculate Totals by
(®) Displayed values
Setup Rules... () Exact values

Cancel

Editing Components

Click the plus sign next to any Key in the Database tree in the left-hand side of the Edit Database
dialog box to see whether the selected Key has Components, Descriptors or both grouped in it, then
click the plus sign next to the Components icon to view the items belonging to the selected Key.

E| @ Components
: o dlka, coOnCrete
s, concrete block 20724740 cm
b, Concrete

Sitework
E| Concrete
@ Components
; g Dezcriptors

hazanry

oo il precast concrete plank
m Descriptors

To edit any of the Component records in the selected Database, highlight its name in the Database
tree. The right-hand side of the dialog box will display the attributes of the highlighted component.
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Edit Database
Databases in Active Libraries:
General
Sitework
hd Concrete

hd @ Components
ks lightweight concrete
4 structural concrete
ks lightweight concrete
4 concrete
s concrete block 20%24%48 cm
s concrete

ks precast concrete plank
| Pone rriobnen

w Details of Database items on the same level

Code MName

032 lightweight concrete

04 structural concrete

035 lightweight concrete

1226 concrete

1845 concrete block 20%24*49 cm
2053 concrete

2358 precast concrete plank

Duplicate

Edit Component:

Database:
Key:
Code:
Mame:
Quantity:
Unit:

Reference Quantity:

Quantity
0.050
0.200
0.020
0.150
8.000
1.000
1.000

(=] B (=)

WrchiCAD_Library
003 Concrete
[1228 |
|concrete |
[0.150 |
m3 »
Surface A 3

Unit Ref.Quantity

m3 Surface A

m3 Surface A

m3 Surface A

m3 Surface A

pieces Surface A

m3 Volume

m2 Surface A

Component type database records are identified by their Key-codes and Codes which appear in the
second and third rows of the component attributes in the right-hand side of the dialog box. The
component’s Code can be edited by typing the new number into the corresponding text field.

Components can be moved from one key to another using click-and-drag. You can drop the moved
item either into the Components folder of the new key location if the key is open, or simply drop it
into the Key folder. In the latter case, the moved component will automatically be placed in the

Components folder of the key.

Edit the component’s name directly in the Name text field, or by clicking on its name in the

Database tree.

The bottom three rows of the component’s attribute controls allow you to define:

e the Component Quantity

e the Unit used to calculate the component

e the number of component units per Reference Quantity unit, e.g., eight pieces of tiles per

square meter of a wall’s inside surface.

ARCHICAD Calculation Guide

22



Editing the Calculation Database

Edit Database (o] ==
Databases in Active Libraries:

[m| General - Duplicate Delete

v [ Concrete Edit Component:
v @ Companents
Database: WrchiCAD_Library

ks lightweight concrete
ks structural concrete Key: 1003 Concrete
ks lightweight concrete

Code: [1228 |
4 concrete
4 concrete block 20%24%48 cm Mame: | concrete |
s concrete
Quantity: [0.150 |
ks precast concrete plank
BB e s I unit m3 C
Reference Quantity: | [tem L4

For more information on Reference Quantity, see Components.

Editing Descriptors

Descriptors are listed in the Database tree in the Edit Database dialog box.
Select any Descriptor to edit it.

Edit Database =] = [
Databases in Active Libraries:
Sitework - Duplicate Delete
hd Concrete
@ Components
hd m Descriptors

Edit Descriptor:

Database: WrchiCAD_Library
0P * Reinforced concrete slab *
Precast Concrete Key: 003 Concrete
Masonry
Code: 22
Metals
‘Wood-Plastic Full Text:
Thermal & moisture protection * Reinforced concrete slab *
52 RDooreWindows w reinforcement: refer to working drawings and
< > reinforcement notes

b Details of Database items on the same level

Descriptors can be moved from one key to another using drag-and-drop in the Database tree.
The descriptor’s full text can be edited directly in the Full Text field.
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Property Objects

What are Property Objects?

Property Object files are special ARCHICAD Library Parts without a 3D Script. Property Objects are
generally used to describe specific structures for the purposes of calculation, e.g., the quantities
and the detailed description of reinforced concrete beams used in the project.

See the Component and Descriptor definitions above.

Hint: Think of a Property Object as a custom cooking recipe including ingredients from your
garden (local components), “in-house” cooking instructions (local descriptors), ingredients that
need to be shopped for (database components) and instructions you commonly find in
cookbooks (database descriptors). Just as the amount of ingredients must be adjusted to the
number of people you cook for, in calculating the actual amount of components of an element,
ARCHICAD calculates on the basis of the given relationship between each component and the
reference parameter of the element calculated.

Data not directly derived from construction elements is contained or collected from databases
through indirect links facilitated by Property Objects.

Properties are used to define quantities and descriptions of construction elements. The two types
of Property definitions are Components and Descriptors. Components and Descriptors (along with
Units) can reside in Databases or be defined locally. Local Properties definition is possible in any
Library Part type element (Window, Door, Object, Lamp etc.) for the exclusive use of the Library
Part, or in Property Objects. As well as local Properties, Property Objects can also access Database
Properties, which are then assigned to construction elements.

Property Objects can be linked to elements either globally by matching certain criteria, or
individually from the Settings dialog boxes of the different elements.

Topics in this section:

Creating and Editing Property Objects

Defining Components and Descriptors

Linking Components and Descriptors to Databases
Linking Property Objects to Element Criteria
Creating Criteria for Property Assignment
Assigning Properties to Elements

Last Selection’s Properties

Locating Property Objects
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Creating and Editing Property Objects

The New Properties command opens a new, empty Property Object file that you are able to edit
using the dialog box controls and ARCHICAD’s GDL language. The effect of choosing this command is

identical with that of the File > Libraries and Objects > New Object command.

-

Untitled-1 o ==
2 Object’s subtype: |Proper‘t}r Objects Select Subtype...
a Use as subtype Placeable
H
9 Author: |
License: | Public Domain Dedication 1.0 «|[®

Password: Set Password...
Details
Pt Description:
Migration
Components |
Descriptors
Scripts
Master D Keywords:
0 |
Properties |
Parameter |
Interface |
2D Symbol |
Preview Picture |
2D View |

Choose the Edit Properties command to select an existing Property Object and edit it in its library
part master window. (You can also edit Property Objects by choosing File > Libraries and Objects >

Open Object and selecting the Properties File type.)

[5] FrooF23 20

MNew Delete Remove Link to Database

=l

Change Link...

Proportional with [Custom):
DE Set Key Code Mame
= ArchiCAD_Library 009 3071

Quantity  Unit

e po

Details
Parameters

Migration

Components

Descriptors
Scripts

Master
2D
Properties
Parameter

Interface

2D Symbol

Preview Picture

I

2D View

Proportional with
hexagonal tile 38,50 pieces Surface A

ArchiCAD_Library maortar 3 Surface &

= B s

Note: If you choose this command while any construction element is selected in the ARCHICAD

Project, all directly assigned Property Objects will open automatically.
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The Property Object type Library Part does not have a 3D Script or a 3D View. Otherwise, the
available controls are similar to those of the other Library Part types, which are described in the
ARCHICAD Reference Guide.

For more information, see the “GDL Master Window” chapter in ARCHICAD Help.

Defining Components and Descriptors

When defining Properties, you should first decide whether they will ever be assigned to different
elements, whether they may ever be parts of different Properties combinations in Property Objects,
or if only one Library Part will use them.

e Aunique object’s properties, e.g., the coating of a custom-made truss, is best defined locally,
within the Library Part.

e More generic Properties, e.g., the amount of cement needed to build elements made of
reinforced concrete, are better described locally in Property Objects so that any such element
can refer to them.

e The most generic Properties, e.g., the amount of paint needed for walls (Component) or general
safety instructions (Descriptor), which are expected to be used in several Properties
combinations are best defined as Database Properties so that any Property Object can refer to
them.

Click the Components button in the left-hand side of the Library Part master window. This will
display the Components controls on top of the window.

[5] FrooF23 20

=l

| Mew Delete Remove Link to Database Change Link... |

Proportional with (Custom)
DE Set Key Code Mame Quantity  Unit Proportional with
= ArchiCAD_Library 009 307 hexagonal tile 38,50 pieces Surface A
ArchiCAD_Library 004 2767 martar 0.02 m3 Surface & 3

e po

Details
Parameters

Lligration

1
I | Components ||

Descriptors

Click the New button to create a new Component line.

Type the desired values or strings into the Code, Name and Quantity text fields to define the
corresponding attributes of the new component.

Use the Proportional With pop-up list to choose a reference quantity (Iltem, Length, Surface,
Volume) for the component.
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The following table shows the components referencing different parameters of ARCHICAD element
types:

Ref.element Length Surface A | Surface B Surface C Volume
Wall (Ref+other)/2 (1) | Ref(1) Other (1) Ref+other Total volume
Column Height Around Around Around veneer | Core+veneer

veneer veneer
Beam (Left+right)/2 Left (2) Right (2) Total Total volume
Slab Perimeter Top Bottom Top+bottom Total volume
Roof Perimeter Top Bottom Top+bottom Total volume
Mesh Perimeter Top Bottom Total Total volume
Zone Perimeter Area Area Area Total volume
Object Along X axis (A) |0 0 Total Total volume
Door/ Width of Width x Width x Surface of Total volume of lib.
Window opening height height library part part elements
elements
Notes:

1. Including surfaces around openings with reveals and along reveal depth. “ref” stands for the
reference line side of the wall and “other” for the side opposite the reference side of the wall.

2. Left andright side of the beam as defined by its orientation; left and right may be different when
the beam is connected to a wall at a non-perpendicular angle.

Some values are intentionally different from appropriate element list values, as the associated
components are usually calculated based on different surfaces. For example, you may want to
calculate the painted surface of a wall: in this case, you are not interested in the edge surface

but in the sum of the reference and opposite side surfaces of the wall.

To define a special reference, choose Custom from the Proportional with pop-up list. This will make
active the field that the ‘Proportional with’ header points to, on top of the headers. Enter any GDL
expression using global and local variables.

Mew Delete Remove Link to Database Change Link...
| |
|Propor‘tiona| with [Custom]: |\""”i\l-'--'”"'CKNESS I |
DE Set Key Code Mame Quantity  Unit Proportional with
= ArchiCAD_Library 009 307 hexagonal tile 38,50 pieces Surface A

ArchiCAD _Library 004 2767  mortar 0.02 m3

You define Descriptors in much the same way. Click the Descriptors button to display the
appropriate controls on top of the window.
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[5] FrooF33 20
I Mew Delete Remove Link to Database Change Link... Text...
i) DE Set Key Code Short Text
u} ArchiCAD_... 009 3 -hexagonal tiles, 10 cm edges
]
Details
Parameters
Migration
Compaonents
I | Descriptors ||

Click the New button to create a new Descriptor line.

Type the desired value in the Code text field and the appropriate Short Text (first line) in the
corresponding text field.

Mew Delete Link to Database [tem... Change Link... Text...
DE Set Key Code Short Text
= ArchiCAD_... 009 30 -hexagonal tiles, 10 cm edges
B Archica...» | 003 F.» [31] Jmortar blocks ||

Click the Text button to open the Descriptor Full Text dialog box where you can give a longer

description of the part, element or structure. This description may include technical parameters and

specifications or other useful assembling or safety instructions.

B Descriptor Full Text ? *
Code:
Key: 009 Finishes
Cancel
¢ You can modify the Full Text of the Descriptor. The first line of the Full Text is the
|
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Linking Components and Descriptors to
Databases

If you want a Component or Descriptor defined in a Property Object to be identified with a
Database item, select it in the list of the Property Object’s master window, and click the Link to
Database Item button at the top of the dialog box.

Mew Delete || Link to Database [tem... I Change Link... Text...
DE Set Key Code Short Text
= ArchiCAD_... 009 30 -hexagonal tiles, 10 cm edges
B Archica...» | 003 F.» [31] Jmortar blocks ||

The Select Components or Select Descriptors dialog box appears. You can choose from all the
relevant items in the selected database.

[ Select Descriptors ? X
Check Descriptors to be listed: Full Text
V Finishes ~ * Asphalt shingle+concrete plank roof *
I -10 cm wide board siding nailed to 7*4 cm furring
Il * Asphalt shingle+concrete plank roof *
Il -15x%15 cm glazed tiles
0P -25x25 cm ceramic tiles
Il -10x10 cm square + octagonal tiles
Il -hexagonal tiles, 10 cm edges
Il -nailed to plywood subfloor
¥ -applied to plywood subfloor with blind nailing
— PR
w Details of Descriptors on the same level
Code Short Text
13 -10 cm wide board siding nailed to 7*4 cm furringfurring every 45 cmcommon brick with raked jointsin...
23 * Asphalt shingle+concrete plank roof *
27 -15x15 cm glazed tileslaid in 20 mm mortar bedsubfloor protected with water proofing
28 -25x25 cm ceramic tileslaid in 20 mm mortar bedplywood subfloor protected with water proofing
29 -10x10 ¢m square + octagonal tileslaid in 20 mm mortar bedplywood subfloor protected with water pr...
30 -hexagonal tiles, 10 cm edgeslaid in 20 mm mortar bedplywood subfloor protected with water proofing
3 -nailed to plywood subfloor
32 -applied to plywood subfloor with blind nailing

Cancel Edit Database...

As long as a Component or a Descriptor of a Property Object is linked to a Database, the item will be
updated with every update of the Database.

When a selected Component or a Descriptor is already linked to a database item, the name of the
linking button changes to Remove Link to Database, and the Change Link button also becomes
active. You can then either break the link to a database item, or replace it with a different one.

Mew Delete I Remove Link to Database Change Link... I Text...
DE Set Key Code Short Text
= ArchiCAD_... 009 30 -hexagonal tiles, 10 cm edges

ArchiCAD_... 009 * Asphalt shingle+concrete plank roof *

Object-specific items are listed in plain text, database items are listed in italic and the names of
missing database items are grayed.
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Linking Property Objects to Element Criteria

To define a combination of element parameters (type, pen color, size, material etc.) by which a
Property Object is assigned to construction elements, choose the Link Properties to Criteria

command.

A dialog box appears, displaying the links of the default set.

Link Property Objects to Criteria

Show Links in: | Archicap_tibrary

> |

Mew Link Delete

Edit Criteria...

If an element matches these criteria...

Type Fill

D Commaon Brick
J -

|.'

Structural Concrete

@ Enable Property Objects of all links
O Use more specific Criteria only

Link Property Object...

-.use this Property Object

Composite Width/Size Object Name

- = 190 WPOOFmas 20.9...

Stud Partition - CWall12 20.gsm
- PROPWindow 20...
PROPDoor 20.g5m
|| B) PrOPobject 20.g...

Flat Roof - | & croofot 20.gsm

Links between construction elements (on the left) and Property Objects (on the right) are based on
a set of criteria, including element type and different common or tool-specific attributes. Click Edit
Criteria to open the Criteria Selector dialog box (see description below).

The Link Properties dialog box displays four parameters at a time. To see all available parameters,
use the horizontal scrollbar at the bottom of the Criterion List.

Click any column header to sort the list alphabetically.
To link Property Objects to criteria or change the previously assigned Property Object, click Link

Property Object in the upper right of the dialog box while the criterion is highlighted in the list. This
opens the Link Properties to Criteria > Link Properties dialog box.
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Link Property Objects to Criteria

= = 3
Show Links in: ArchiCAD_Library v|
New Link Delete @Enable Proper‘t‘y.Obj.ects. of all links
O Use more specific Criteria only
Edit Criteria... | Link Property Object... |
If an element matc) = _ o " . =
Link Property Objects to Criteria / Link Property Objects | EI = IEI
Compaosite
Choose Manually  Search by Keywords
Stud Partition
Available Property Objects in | all loaded Libraries v|
CSlab04 20 -
CSlab03 20
Cslab02 20
CSlab01 20
CRo0T03 20
CRo0T02 20
CRoof01 20
B wPnOFmas 20 v
¥ Property Object Preview
. \Confirm your selection by clicking the Link button. You can edit the Mew...
0} currently selected Property Object by clicking the Edit... button or create
< == la new Property by clicking the New... button. Edit... Link

The Choose Manually tab page lists available Property Objects in the active libraries in alphabetical
order. The currently assigned Property Object is highlighted in the list. To see the components and
descriptors of highlighted Property Objects, open the Property Preview section of the dialog

window.

Highlight the Property Object you wish to assign to the selected criterion.

If you need help to find Property Objects in the active libraries,

click on the Search by Keywords tab.

Type the keywords in the appropriate text field and press Search to list the Property Objects that

match the keywords.

Link Property Objects to Criteria / Link Property Objects

Choose Manually Search by Keywords

(o] 2 ()

Search in | all loaded Libraries

~ |

Search Keywords: |concrete

| Search

Property Objects including all keywords:
Cslab01 20

CRo0T03 20

CRo0T02 20

CRo0f01 20

[ wion1En a0

Components  Descriptors

Database Keycode Code Mame

Confirm your selection by clicking the Link button. You can edit the
currently selected Property Object by clicking the Edit... button or create

a new Property by clicking the New... button.

WPOOFmas 20

w Property Object Preview [Plain: Database items, ltalic Object-specific items, Grayed: Missing Database items.

v

Quantity Unit

Edit... | Link |

e Click Link button to confirm your selection.
e Click Edit to open the highlighted Property Object
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e Click New to create a new Property Object.

In the Link Property Objects to Criteria dialog box, the two radio buttons give you a choice for how
to interpret multiple criteria whose parameters partly coincide.

Link Property Objects to Criteria EI = @
Show Links in: | Archicap_tibrary vl
@ Enable Property Objects of all links
Mew Link Delet
ewtin clete O Use more specific Criteria only

Edit Criteria... Link Property Object...

Enable Property Objects of all links means that both the Property Object assigned to a simpler
criterion and the one assigned to a more specific criterion will be applied to matching elements. An
example:

The simpler criterion includes only two parameters, wall Type and solid brick Fill, and the assigned
Property Object is one whose components are bricks and mortar.

The more specific criterion includes three parameters of which two, wall Type and solid brick Fill,
are identical with those of the simpler criterion. The third parameter is whitewash Material, and the
assigned Property Object’s only component is plaster. In this case, the construction elements
matching the more specific criterion will receive not only the plaster component but also the bricks
and the mortar. Elements matching the simpler criterion only (non-plastered walls) will receive the
bricks and the mortar but not the plaster.

If you choose Use more specific Criteria only, a match to a more specific criterion always overrides
a match to a simpler one. Elements matching a certain criterion will only receive the Property
Object linked to that particular parameter combination. In the above example, the elements
matching the criterion with three parameters would receive the plaster component only.

Only one criterion can be selected and edited at a time.
Click Edit Criteria to open the Criteria Selector dialog box.

Criteria Selector n
Find Elements: [ wan v m
Fewer Choices

Fill ’ Common Brick ’
Width Y [ [E
=

More Choices

Apply

Choose the Element Type for the active criterion from Find Elements pop-up, and click More
Choices as needed to select and define additional criteria.

Save, load and rename or delete criteria sets using the commands from the pop-up list at the top
right of the Criteria Selector dialog box. The list items activate the corresponding dialog boxes
where you can perform the desired action.

Criteria Selector n
Find Elements: [ wan v B s
4 Load...
Fewer Choices Rename & Delete...
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The Copy Settings button is only active if a construction element is selected in the project. Click this
button to set the parameter values to match those of the selected element.

Criteria Selector n
Find Elements: [0 wan v @
Fewer Choices

Fill v EEE common Brick 3
Width v 1 [= |90
—
Mare Choices | I:I_?l
Apply

Note: This action will also set the element type.

Click Apply to update the Criteria list.

Creating Criteria for Property Assignment

In order to create calculation reports that use the Properties information, Properties data must be
linked to construction elements.

Properties can be associated with construction elements through Criteria or individually.
Assignment through Criteria is defined with the Link Properties to Criteria command.

Link Property Objects to Criteria EI =] @

Show Links in: | Archicap_tibrary |

@ Enable Property Objects of all links

Mew Link Delet
ewtin clete O Use more specific Criteria only
Edit Criteria... Link Property Object...
If an element matches these criteria... -.use this Property Object

Type Fill Composite Width/Size Object Name
J Commaon Brick - = 190 WPOOFmas 20.9...
J - Stud Partition - CWwall12 20.gsm
F - - - PROPWindow 20...
- | PROPDoor 20.g5m

L . _ - || B) PrOPobject 20.g...
Structural Concrete - I SPO2FO0 20.gsm
Flat Roof ; ] CRoof01 20.gsm

Each Property Object can be associated to a unique combination of element selection criteria, e.g.,
the Property Object called “Concrete Wall” can be associated with all walls of concrete block fill,
drawn in pen No.12, and placed on the “Exterior Walls” layer. When this option is active, ARCHICAD
filters the project’s construction elements and automatically links the Property Object in question
to all elements matching the given Criteria. Criteria sets are saved within the active Library so that
they can be used in multiple projects.
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Note: You can check this assignment by selecting an element, opening its settings dialog box and
clicking the Listing Panel.

Note: The Listing Panel is not visible by default. To enable it in any construction element’s
settings, go to Options > Work Environment > Tool Settings Dialog Boxes.

You can also choose to assign Property data directly, individually for each element in the Listing
Panel of its Settings dialog box or in the Info Box.

Note: The Listing Panel is not visible by default. To enable it in any construction element’s
settings, go to Options > Work Environment > Tool Settings Dialog Boxes.

A combination of Criteria-based linking and direct Assignment is also possible.
See also Creating and Editing Property Objects.

Assigning Properties to Elements

When editing a construction element in its Settings dialog box, you can assign Property Objects to
the element in the Listing panel.

I Wall Selection Settings ? *

kg Selected: 1 Editable: 1

» Ot GEOMETRY AND POSITIONING
» [A FLOOR PLAN AND SECTION
» (] MODEL

- ‘ LISTING

|:| Link Property Objects By Criteria

Indi\ridually Choose... CWall12 20.gsm

3 ‘CATEGORIES AND PROPERTIES

<@> Structural - Bearing L Cancel

Note: This panel is not visible by default. To enable it in any construction element’s settings, go
to Options > Work Environment > Tool Settings Dialog Boxes.

The link can be made by criteria or individually.

To assign a Property Object through criteria (that is, all elements that match the criteria selection
made in the Link Property Objects to Criteria dialog box - see above), check the Link Property
Objects By Criteria box in the Listing panel. Property Objects that match these criteria will be shown
in the panel.

You may wish to override this setting by creating a specific assignment for a particular element. In
this case, uncheck the Link Property Objects By Criteria box, check the Individually box below and
click Choose.

Note: It is possible to keep both checkboxes active at the same time and thereby create a
combined assignment.
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Link Property Objects
perty Ubj

Choose Manually Search by Keywords

Available Property Objects in | all loaded Libraries

CWall12 20 -

cwall1120
cwall10 20
cwallog 20
Cwallos 20
Cwallo7 20

Cwallos 20

B cwanns 2n

~ |

Assigning the Property Object manually or through keywords is done the same way as for criteria,
as described earlier in this chapter.

Last Selection’s Properties

Selected Property Objects cannot be edited directly from the Settings dialog box. Use the Last
Selection’s Properties command to access Property Objects from construction elements to which

they have been assigned.

If any construction element is selected in the project, use Last Selection’s Properties to see which
Property Objects are linked to the selected element.

Select a property object and view its details in the Contents section of the dialog box.

Database

ArchiCAD_Libr...
ArchiCAD_Libr...
ArchiCAD_Libr...
ArchiCAD_Libr...
ArchiCAD_Libr...
ArchiCAD_Libr...

Components  Descriptors

Keycode
006
006
006
006
009
009

Flain: Database items
ltalic: Object-specific items
Grayed: Missing Database items

Last Selection's Property Objects

Property Objects matching Element Criteria:

Property Object linked to Element individually:
CwWall12 20.gsm

w Contents of the selected Property Object

Code

109
110
111
112
1851
520

MName

wood stud 9.5%4.5 cm
wood noggins 9.5%4.5 cm
wood sole plate 9.5%4.5 cm
wood head plate 9.5%4.5 cm
regular gypsum wallboard
regular gypsum wallboard

Quantity
3.000
0.860
1.000
1.000
1.000
1.000

(o] 2 ()

Unit
m

m

m

m
m2
m2

Edit...

Click the Edit button to the selected Property Object to modify it directly in the Library Part Editor, if
the selected Property Object item is object-specific. If the selected item belongs to a database, click
Change Link in the upper right of the window to modify the item.
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Locating Property Objects

You may need to locate a Property Object that contains a specific component or descriptor, or one
which includes links to a specific database or a specific key.

These two commands help you find what you need:

e Find Property Objects by Properties
e Find Property Objects by Elements

Use these commands to search based on a set of criteria.

Find Property Objects by Properties

Enter criteria and search terms as needed, then click Find Property Objects.

Find Property Objects by Properties n
Criteria:

|Property Object Mame v| |contains V| roof L

O ]

O

Include Property Objects without Components/Descriptors Find Property Ohjects

CRoof(1 20
CRoof02 20

CRoof(3 20

Edit...

Highlight a Property Object name and click Edit to open the Edit Properties dialog box.

Let’s say you want to find all Property Objects within your ARCHICAD Database that has the text
'tile' in its Component Name. You would select the below two criteria.

Find Property Objects by Properties n
Criteria:

|DatabaseName v| |contains V| ArchiCAD_Library L

|ComponentName v| |contains V| tile L

O

|:| Include Property Objects without Components/Descriptors Find Property Ohjects

CSlab01 20
CSlab03 20
FPOOF33 20
FPOOF44 20
FPOOF45 20
FPOOF48 20
FPOGF45 20
RPOSFO0 20

Edit...
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Find Property Objects by Elements

7
-]

Find Property Objects by Elements

Selected: 16 Editable: 16
Criteria:
|ComponentName v| |contains V| stud L
O
O
@ Selection (’;5 %es %
X - +

You have all Walls selected on the Floor Plan. You want to find only those Walls that have studs in
them. Enter the criterion shown above, then click the 'cross-section' button (cross-section of

Selection and Criteria). As a result, only those walls are now selected whose associated Property
Objects contain Components with 'stud' in their Name.
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List Schemes and Templates

List Schemes are factory default or user-defined instruction sets to control how the Listing Engine
processes and displays project information. List Schemes can be independent files or can reside in
Databases.

B Default Set

E Element List Schemes

=, Component List Schemes

- | Zone List Schemes

{Untitled Scheme File LIS}

List Schemes are of Element, Component and Zone types.

It is also possible to create complete List Scheme files that contain definitions for Element,
Component and Zone lists.

List Schemes can be configured to suit a large variety of needs, and new schemes can be created in
the Set up List Schemes dialog box, accessed with the Set up List Schemes command. Moreover,
graphic outputs are highly customizable using a Format Wizard (Windows) or Format Assistant
(Mac).

See Using the Format Wizard/Format Assistant.

Templates

Graphic List Schemes are based on templates that contain information about the list’s structure,
layout and content.

Templates can be of two types:

e Template files are simple text files residing in the active library. They are factory-shipped or
created manually. It is also possible to create copies of embedded templates by saving them as
external files.

e Embedded templates, created with the Format Wizard, reside in the list scheme itself. You can
transform them into template files by unchecking the Include in List Scheme box on the Setup
List Schemes dialog box’s List Format tab page (see later).

Note:

e Templates are coded in a simple programming language. It is highly recommended not to
edit these files unless you are thoroughly familiar with the syntax.

e Template files cannot be edited with the Format Wizard.

Records and Fields

Graphic Templates define layouts to display and print information units called Records. Records are
small layouts that can include numerous Fields and one bitmap image. Fields are units of
alphanumeric data. Field contents are collected, filtered and calculated by the ARCHICAD Listing
Engine. The bitmaps can be external image files from any of the active Libraries, ARCHICAD object
symbols, 3D drawings generated by Property Objects and by the objects themselves, or Preview
Pictures of ARCHICAD Library Parts in the active Libraries.

See Graphic Template and Using the Format Wizard/Format Assistant.
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The Setup List Schemes Dialog Box

The Setup List Schemes command takes you to a complex dialog box where you can define which
element types, components or zones will be calculated by ARCHICAD to produce the required
report, as well as the complexity and format of the output.

& Set Up List Schemes ? X
Edit Selected List Scheme: Default copy
Available List Schemes: Duplicate...
Delete Elements Properties & Parameters List Format
v Default Set by Types: AII |:| Skip Elements without an associative label
Vv [y Element List Schemes E] = D (73. -j@:— . [j [ skip Elements with an empty ID field
% Basic Reduce Wall Quantities if an z
- 1.00 m*,
@ Default E e F‘]ﬁ % w % @ Opening is larger than
@ General Element List ﬁ 11 _tl’ i:t m
@IZ, Window schedule Type 1 ..by Linked Property Objects: List Fills and Objects Included In:
@IE, Window schedule Type 2 | All Elements v| | Floor Plans v|

r@ Default copy

X ..by Layers: All ~ | ..by Stories: AII
&/ Component List Schemes
[ <> [R] ARCHICAD Layer A 0. Story
Ty Zone List Schemes <S> - Hidden
Kostenermittiung [ <&> 2D Drafting - General
= . . [ <&> 2D Drafting - Hotspot
ArchiCAD _Library [ <&> Annotation - General
RoofMaker 2.1 H <@ Annotation - Label
[ <& Annotation - Structure
[ <&> Annotation - Text W

Choose the Setup List Schemes command to open the corresponding dialog box.

The Database tree (at the left-hand side of the dialog box) contains the available Databases, marked
with the filing cabinet (&) icon, and the List Schemes in the List Scheme folders. This list includes all
the list schemes that are in databases placed in active Libraries.

Note: List Schemes will function in Teamwork projects only if you save them to the project’s
Embedded Library.

List schemes are arranged in a hierarchy, organized by type in three folders: the Element, the
Component and the Zone List Schemes. Each folder includes at least some default sets, even if no
Library is loaded, including a Basic list.

& Set Up List Schemes

Available List Schemes: Duplicate...

] Default set
T Element List Schemes

&/ Component List Schemes

&y Zone List Schemes

Kostenermittlung
ArchiCAD_Library
RoofMaker 2.1

User defined Schemes appear in the same hierarchy under the default Schemes. Plain Text Schemes
are marked with spreadsheet-like icons.
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A T Element List Schemes ~
% Basic
(@] Default

@ General Element List
@ Window schedule Type
@ Window schedule Type

u% Default copy
asiccopy
e Schemes belonging to a database can only create lists from their own databases.
e Schemes that are independent from any database can be used for listing all loaded databases.

Select a List Scheme from the tree to see its configuration on the right.

Managing List Schemes

Click Create to create a new List Scheme, or select an existing one and click Duplicate.

[ Set Up List Schemes

Edit Selected List Scheme: Window schedule Type 2

Available List Schemes: Duplicate...

w = Elem Component List Scheme
B ra Zone List Scheme

Note: List Schemes will function in Teamwork projects only if you save them to the project’s
Embedded Library.

Rename the new untitled Scheme or any other List Scheme by selecting its name and retyping it.
Click the padlock toggle to lock or unlock a List Scheme for editing.

% Basic
(nlE, Default
E% General Element List
ﬁ Window schedule Type 1
% Window schedule Type 2

To remove List Schemes, select the name, and click the Delete button.

Important: Clicking OK in the Setup List Schemes dialog box will overwrite all changed List
Schemes that are stored in the Preferences file of the Project and in the LISTSET.TXT database
file placed in the Library.

e When starting ARCHICAD without opening a project file, List Schemes are loaded from the
Preferences files (Listset files /*.lis/ will not be loaded from any of the loaded libraries);

e When opening a Project file, List Schemes stored in the project will be loaded. (Listset files /*.lis/
will not be loaded from any of the project’s libraries).

e When choosing File > Libraries and Objects > Library Manager, all List Schemes (*.lis) found in
any of the selected libraries will be loaded.

Note: List Schemes will function in Teamwork projects only if you save them to the project’s
Embedded Library.

ARCHICAD Calculation Guide 40



List Schemes and Templates

Editing List Schemes

You can edit, modify and customize unlocked list schemes by selecting from the Available List

Schemes area on the left.

Depending on the List Scheme type selected, the right-hand side of the dialog box will display three

or four tab pages.

e When selecting Element or Component List Schemes, three pages appear: the Elements page,
the Properties & Parameters page, and the List Format page.

e If the selected List Scheme is a Zone List, you can see four tab pages: Zones, Properties &
Parameters, Related Elements, and List Format. Click the tabs to switch between pages.

Elements Tab Page

This is the first tab page. Use the controls (filters) in this page to select the construction elements to
be calculated.

& Set Up List Schemes ? X
Edit Selected List Scheme: Default copy
Available List Schemes: Duplicate...
Delete Elements Properties & Parameters List Format
v Default Set by Types: AII |:| Skip Elements without an associative label
v [l Element List Schemes [:] = D (73. -j@:— . [j [ skip Elements with an empty ID field
% Basic Reduce Wall Quantities if an _ 2
- 1.00 m*,
@ Default BE] e F;lla % w % @ Opening is larger than _
@ General Element List ﬁ tt _tl’ n m
@IZ, Window schedule Type 1 ..by Linked Property Objects: List Fills and Objects Included In:
@IE, Window schedule Type 2 | All Elements v| | Floor Plans v|
Izl Default copy
r@ ...by Layers: All ~ | ..by Stories: A an
Iﬁ Component List Schemes
[ <> [R] ARCHICAD Layer A 0. Story
IﬁZone List Schemes F<> - Hidden
Kostenermittiung [ <&> 2D Drafting - General
= . . [ <&> 2D Drafting - Hotspot
ArchiCAD_Library [ <&> Annotation - General
RoofMaker 2.1 H <@ Annotation - Label
[ <& Annotation - Structure
[ <&> Annotation - Text W
Filter by Element Type
by Types: AII

&l ¢ 2] 1]
B B[22 ¢
EFAAEIEIES

Use the filter buttons with the familiar tool icons to determine which element types to list and
which to exclude from report calculations. Click the All checkbox to select all construction element

types.
Note: Unchecking the All checkbox will activate the custom setting last used.
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Filter by Label and ID

Elements Properties & Parameters List Format

by Types: DAII |:|Skip Elements without an associative label

Elr::::[ D (73.|@ ”%”D [ skip Elements with an empty ID field
Reduce Wall Quantities it
ORI (| oo™ [1m—w.

R AR R e gl S

Use these checkboxes to further filter the Element List for any element without an associative label
and/or elements that have no associated ID.

Reduce Wall Quantities Based On Opening Size

Elements Properties & Parameters List Format

by Types: DAII |:|Skip Elements without an associative label

EI = D (73.|@ ”%” [j | [ skip Elements with an empty ID field
Reduce Wall Quantities it
5 ORI & 0 [t m

R AR R e gl S

The Reduce Wall Quantities option allows you to set the minimum size of wall opening that will be
taken into consideration by ARCHICAD in wall surface and volume calculations. Type the size limit in
the text field in accordance with local building code or project requirements.

Filter by Layer

Elements Properties & Parameters List Format
by Types: DAII
Els| U AF&] 1]
B DR R @
EEilR S sRe (oY

..oy Linked Property Objects:
[ Al Elements ]

I ..by Layers: I All £
4 <@> [a] ARCHICAD Latall
<> - Hidden All Visible
[ <> 2D Drafting - Gy 3elected
[ <&> 2D Drafting - Hotspot
[ <&> Annotation - General
[ <2> Annotation - Label

[ <& Annotation - Structure
[ <&> Annotation - Text W

Elements on unchecked layers will not be calculated. The pop-up menu allows you to list elements
on All layers, Visible layers or Selected layers.

ARCHICAD Calculation Guide 42



List Schemes and Templates

Filter by Story

Elements Pproperties & Parameters List Format
Jan
(A | P8 ”% ” [j | [ skip Elements with an empty ID field

Reduce Wall Quantities if an

by Types: |:| Skip Elements without an associative label

=151

3
E |a” F‘]ﬂ |% w % @ Opening is larger than w7
..oy Linked Property Objects: List Fills and Objects Included In:
| All Elements v| | Floor Plans v|
.. by Layers: All ~ (I ..by Stories: AII
[ <> [R] ARCHICAD Layer A 3. Story
<< - Hidden [ 2. story
[# <&> 2D Drafting - General 1. Story
[ <&> 2D Drafting - Hotspot [ 0. Story
[ <&> Annotation - General

[F <&> Annotation
[F <&> Annotation
[F <&> Annotation

- Label
- Structure
- Text W

The Stories scrolling list allows you to include elements placed on selected stories in calculations.
Elements on unchecked stories will not be calculated. Click the All boxes to select all stories.

Filter by Property Objects

Elements Properties & Parameters List Format
by Types: DAII
Els| U AF&] 1]
B DR R @
e A AR s

..oy Linked Property Objects:

All Elements -

Elements Linked to Selected Property Objects

Select Property Objects...

Use the Linked Property Objects pop-up list to determine whether you want to select particular
Property Objects to further elaborate listing criteria.

e Choose All if you do

not want to use this filter.

e Choose Elements Linked to Selected Property Objects if you wish to calculate elements to
which certain Property Objects are assigned either by criteria or in the element’s own Settings

dialog box.

e To make the Property Object selection, e.g., for listing construction elements made of reinforced
concrete only, choose Select Property Objects in the pop-up list to open the corresponding

dialog box.
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Check Property Objects of the loaded libraries to be listed:

CF T Test.apx
[F ToP stamp.apx

I Embedded Library
v [EIF] ARCHICAD Library 20

OB Froors3 20
OB FrooF3s 20
FPOOF40 20
FPOOF41 20
FPOOF42 20

L T

¥ Cumulated contents of checked Property Objects

Components  Descriptors

Database

ArchiCAD_Libr...
ArchiCAD_Libr...
ArchiCAD_Libr...
ArchiCAD_Libr...
ArchiCAD_Libr...
ArchiCAD_Libr...
ArchiCAD_Libr...

Arrbim AP Lilar

Keycod
002
003
003
003
003
003
003

nAna

" List an element if ...
. its individually linked, or
ALL of its “by-criteria” linked
Property Objects are checked,

oo ALL of its linked Property
Objects are checked.

. ANY of its linked Property
Objects are checked.

List Schemes and Templates

Flain: Database items
ltalic: Object-specific items
Grayed: Missing Database item:

e Code Mame ‘Quantity Unit
818 grout 0.050 m3
032 lightweight concrete 0.050 m3
032 lightweight concrete 0.050 m3
04 structural concrete 0.200 m3
04 structural concrete 0.200 m3
04 structural concrete 0.200 m3
04 structural concrete 0.200 m3
noa cbevirbi il rm e A ann 3

The checkboxes next to folder names have three states: checked, unchecked, or minus. If the
checkbox is checked or unchecked, all items in the folder in question will be used or ignored when
filtering the project. If only some items are checked, a minus sign will appear.

View the components and the descriptors of the Property Objects at the bottom of the dialog box.

Filter Listed Fills and Objects by Viewpoint

The List Fills and Objects pop-up menu allows you to list Fills and Objects that are included in
particular project viewpoints.

Elements Properties & Parameters List Format

..by Types: EA a0

D= LA A D
B 1= R RIS ¢
EE [ |

..oy Linked Property Objects:

|:| Skip Elements without an associative label

|:| Skip Elements with an empty 1D field

Reduce Wall Quantities if an z
1.00 m*,

Opening is larger than

List Fills and Objects Included In:

| Elements Linked t... Property Objects v|

.. by Layers: All

[ <> [R] ARCHICAD Layer
<< - Hidden

[# <& 2D Drafting
[# <& 2D Drafting
[F <&> Annotation
[F <&> Annotation
[F <&> Annotation
[F <&> Annotation

- General
- Hotspot
- General
- Label

- Text

- Structure

Floor Plans
Floor Plans
Sections
Elevations

Interior Elevations
Warksheets
Any Selected Viewpoints

Select Viewpoints...

Once you choose a viewpoint type, a subdialog appears allowing you to choose any particular
viewpoints of that type (e.g. certain Elevations) to include in this filter. (To include all viewpoints of
the chosen type, check the “All” box in the subdialog box.)

To include several types of viewpoints, choose the “Any Selected Viewpoints” option, then go
through the subdialog and check any viewpoints, of any type, to include in this filter.
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[ Select Viewpoints ? X

Select Elevations: Clan

[ East Elevation / Autorebuild Model

O Morth Elevation / Autorebuild Model
South Elevation / Autorebuild Model
[#l West Elevation / Autorebuild Model

Properties & Parameters Tab Page

The second tab opens the Properties & Parameters page. Use the controls in this page to determine
the amount of information included for each element in the report.

& Set Up List Schemes ? X
Edit Selected List Scheme: General Element List
Available List Schemes: Duplicate...
Delete Elementd Properties & Parameters |ist Format
Default Set Keys: EA a0 Global Element Parameters:
Kostenermittlung Default Set i/ Element type HE
v ArchiCAD_Library Kostenermittiung O section Pen
v @ Element List Schemes ArchiCAD_Library O Composite Section Pens
.7.% Basic O Line Type
= O Building Material/Composite/Profile Na...
@k Defautt O skin Cut Fill Names
r@ General Element List O skin Building Material Names
@ ‘Window schedule Type 1 EEu.t FlI.I“P_en 2
@ Window schedule Type 2 Components: Extra Parameters of the Selected Types:
c t List Sch | Mone v| 03D Resolution of a Curved Wall -
lﬁ omponent Hst sehemes R i O Direction of the Wall
[ Zone List Schemes EEE L [ start Thickness of the Wall
| Mone V| O End Thickness of the Wall
. . - O'wall Skin Thickness on the Qutside Face
Lib Parts’ Additi I P; ters:
LI Ll tHona’ Farameters O'wall Skin Thickness on the Inside Face
| Nane V| O wall Insulation Skin Thickness W

Select Keys

Keys are logical categories in Databases, which group the primary Database items - Components
and Descriptors - by type.

Select the desired Keys for filtering the components and descriptors to be listed. You can only select
Keys from the Database in which the selected List Scheme resides. In the case of a database-
independent scheme, you can select Keys from any of the existing databases.
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Select Components and Descriptors

Use the Components and Descriptors pop-up lists to determine the combination of components

and descriptors to be listed.

Elements Properties & Parameters [jst Format

Keys: D All
OE]J pefauit set
? D Kostenermittlung
ArchiCAD_Library

Elements Properties & Parameters [jst Format

Keys: D All
OE]J pefauit set
? D Kostenermittlung
ArchiCAD_Library

Components:
Components: All v|
All Descriptors:

Mone |v|

Mone

From Databases Only

Object Specific ltems Only
Custom Set From Databases Only
Custom Set & Object Spec. [tems

Customize...

All

From Databases Only

Object Specific ltems Only
Custom Set From Databases Only
Custom Set & Object Spec. [tems

Customize...

Choose All to include all related Components (or Descriptors) in the calculation.

Choose None to ignore Components (or Descriptors).

Select one of four global options:

From Databases Only will include all properties (Components or Descriptors) residing in databases.
Object Specific Items Only will include only locally defined properties (those in regular library

parts or Property Objects).

e Custom Set From Databases Only opens the Select Descriptors and the Select Components
dialog boxes, where you can define the set of properties to filter the report.

e Custom Set & Object Specific Items is a combination of the second and third options.

¢ If you want to use a filter set that does not match any of the predefined options, use the
Customize button.

Example:

Let us say you have a Wall with a Property Object assigned to it, in which the following Components

are created:

[& FrooF3z 20

I Mew Delete Remove Link to Database Change Link...
Proportional with [Custom):
DE Set Key Code Mame Quantity  Unit Proportional with

e po

ArchiCAD_Library precast conc.. Surface & 3
= ArchiCAD_Library 004 1344 plaster 0.04 m3 Surface A
= ArchiCAD_Library Gravel 0.900 m3 Volume
Details = ArchiCAD_Library Water 0.500 m3 Volume
e = ArchiCAD_Library Cement 300.00 MISSING  Volume
Migration
| Components |

Descriptors

The first two are taken from the Database by clicking the 'Link to Database Item..." button in the top
row and selecting an item from the Database for each.
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The other three Components are Local Components of the Property Object, meaning they will not
become part of the Database so they are accessible for only those Elements and Objects to which
this specific Property Object is assigned.

Depending on how you filter components in Setup List Schemes, the resulting element list will vary:

Elements Properties & Parameters [jst Format

Keys: D All
OE]J pefauit set
? D Kostenermittlung
ArchiCAD_Library

Components:
All

Mone

From Databases Only

Object Specific ltems Only
Custom Set From Databases Only
Custom Set & Object Spec. [tems

Customize...

e All: All five components are listed.
¢ None: Nothing is listed.
¢ From Database Only: Only the first two components, linked to the database, are listed.

e Object Specific Items Only: Only the last three components, which are local to this property
object, are listed.

Select Parameters

In the Global Element Parameters list, choose any of the common parameters of all element types,
such as surface, volume, height, thickness or user ID.

Shift-click to multi-select.

The Extra Parameters lists those which are specific to the selected element type(s).

Under Library Parts’ Additional Parameters, the Select Additional Parameters dialog box allows
you to select parameters by type and one-by-one.

Elements Properties & Parameters [jst Format

Keys: DAII I Global Element Parameters:l
OE] pefaut set [ Element type o
— . O View Pen
O] kostenermittiung Section Pen
|:| MewDatabase O Composite Section Pens
O Line Type

ArchiCAD_Library Building Material/Compaosite/Prafile Na...

O Skin Cut Fill Names
[ 5kin Building Material Names

O Cut Fill Pen W

Components: IEx'tra Parameters of the Selected Types: I
| All v| [€'W,D Reveal Depth to Wall Face ~
D —— [ W/D Mominal Sill Height

esdriptaors: W,/D Sill Height on the Reveal Side
| Maone V| Ow/D Sill Height on the Side Opposite t...

} . " OwW/D Jamb on the Left Side
Lib Parts’ Additi I P; ters: :

[ iorary Parts Adaitional Parameters: | CIW/D Jamb on the Right Side

Nane |V| O w/D Sill/Threshold Depth W

o —— T

As in Selected Library Parts

Select Additional Parameters... Cancel
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List Format Tab Page

The third tab opens the List Format page. The controls

in this page allow you to define the overall

appearance of the report, and set the logical order of properties and parameters.

Choose one of the formatting alternatives: click Text List to display raw data, or Graphic Template

to select a predefined list format template.

Elements Properties & Parameterq List Format
@GrapthTempIate I

Start Format Wizard...

Template: Window schedule Type 1 Dlnclude in List Scheme
Version: 110 Window schedule Type 1 layout Choose Template...
List on separate level
Use for Grouping & Total
Farameter:
o1 4 Library Part Name O
0z *+ Thickness/Size O
03 $ Height Oa
04 % UserD O
05 + Reveal Side is Opposite to the Openi... []
06 + Surface Name O

These two radio buttons let you toggle between two co

Plain Report

ntrol windows, described below.

The following page appears when clicking Text List button from the List Format tab page.

Elements Properties & Parameters List Format

O Graphic Template

Elements: | Each Item in Separate Row v| Separators: Show Column Headers
Components: | Quantity only v| Columr: D

Descriptors: | Short Text anly v| Row: |:| Mark for ‘None” |I|

Farameter: Use & Define Custom Headers:

o1 Library Part Name [ |

0z *+ Thickness/Size O

03 $ Height Oa

04 % UserD O

05 * Reveal Side is Opposite to the Openi... Oa

06 + Surface Name O

When you choose this report format, you have only a limited number of controls over the report
layout. However, the report will appear in a text window and the list settings fully enable you to

logically organize the data in the report.
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Sorting Order

To change the default order, drag the parameters to their new position in the list.

Elements Properties & Parameters List Format

OGrapth Template
Elements: | Each Item in Separate Row v| Separators: Show Column Headers
Components: | Quantity only v| Columr: D
- Row: Mark for ‘None”
Descriptors: | Short Text only | [-] /]
arameter: Use & Define Custom Headers:
o + LLibrary Part Name Oa
06 = [urface Name ]
0z $ [Thickness/Size O
03 + Height Oa
04 + JuseriD O
05 + [Reveal Side is Opposite to the Openi... Oa

Column Headers

Check the Show Column Headers checkbox if you want to print column headers in the report.
Column headers will bear either the parameter name or a Custom Header. To create a Custom
header, check the box next to the Parameter name you want to customize and type the desired

header into the text field.

Elements Properties & Parameters List Format

(@ Text List ) Graphic Template
Elements: | Each Item in Separate Row v| Separators: Show Column Headers|
Components: | Quantity anly v| Cotumn: [| |

- Row: Mark for ‘None”
Descriptors: | Short Text only | [-] /]

Farameter: Use & Define Custom Headers:

o + Library Part Name |
02 Surface Name CineRender Surface Name| .
03 + Thickness/Size Ll
o4 $ Height Oa
05 % UserD O
o6 * Reveal Side is Opposite to the Openi... Oa

Listing Preferences

Use the three pop-up menus in the upper part of the tab page to define the listing logic.

At Elements, the Each Item in Separate Row option creates an item by item list even for identical
elements, while Group and Count Identical groups and counts up identical items as well as their
parameters. For the difference, see the following reports:

Elements Properties & Parameters List Format

Components:

Descriptors:

OGrapth Template
Each Item in Separate Row |+ Separators: Show Column Headers
Each [tem in Separate Row Column: D
e
Group & Count Identical Roae |:| Mark for ‘None': |I|

At Components, the Unfold Components option lists the parameters of the components. Quantity
Only will display quantities without units.
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At Descriptors, the Unfold Descriptors will list all the Parameters, Keys and Codes of the
Descriptors. Short Text only displays only the first line of the descriptor in the report.

Note: Text lists can be saved in plain text, tabbed text or HTML format. Text lists will only list the
short text of Descriptors.

Graphic Template
This page appears when you click the Graphic Template radio button on top of the List Format tab
page.

Elements Properties & Parameters List Format

2 O Text List | . (® Graphic Template | Start Format Wizard...

Template: Window schedule Type 1 |:| Include in List Scheme

Version: 110 Window schedule Type 1 layout Choose Template...

List on separate level
Use for Grouping & Total

Farameter: Use & Define Custom Headers:
o1 % Library Part Name O
02 . Surface Name CineRender Surface Name .
03 % Thickness/Size O
o4 $ Height Oa
05 % UserD O
o6 * Reveal Side is Opposite to the Openi... Oa

With a Graphic Template, you can either select a predefined list template from your Library, or use
an embedded template layout (or a copy of it).

List layout templates offer sophisticated ready-to-present report formats incorporating both text
and graphic elements.

Reports formatted using templates appear in a non-editable project windows. The contents of the
windows can be copied to the other project window, including the floor plan views, or saved in
ARCHICAD Project, RTF and PlotMaker layout format.

Click the Choose Template button to browse the library for list templates. Select the desired
template file in the Open dialog box. Default templates can be found in the List Templates folder of
the ARCHICAD Library.

If you use independent templates, ARCHICAD refers to the actual template file for the settings. If
you check the Include in List Scheme checkbox, the template file will be archived in the listset.txt
file (see above). When the box is checked, the template name appears in italic.

Data Order and Parameter Options

See the Text List section above on how to rearrange the order of data columns and customize
columns headers.

If the list of parameters includes Components or Descriptors, use the checkboxes to define
additional list items.

Note: Changing data order can result in inconsistent list content if the template contains fixed
column headers.
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Parameter Listing

Element List template files can include instructions to list element parameters separately and/or
add up parameter values in the report. Define your preference for each parameter using the
appropriate checkbox:

Elements Properties & Parameters List Format

O Text List (® Graphic Template Start Format Wizard...
Template: |General element list [Jinclude in List Scheme
Version:  [1.10 |General element list layout Choose Template...

List on separate level
Use for Grouping & Total
Farameter: Use & Define Custom Headers:

o1 Element type -~
02| Story Mame / Viewpoint Name

03 Layer Mame

04 User ID

06
o7
08

Thickness/Size
Height
Surface Area

ioooooooms

05 * Library Part Name

e List on separate level: List parameter types for each element
e Use for Grouping/Total: add up parameter values in the report

Component Lists

When selecting a Component List type scheme, the Setup List Schemes dialog box changes
accordingly, to display controls available for that list type.

Many of the controls are similar to those used for Element Lists. See relevant sections above.

Components Tab Page

In the Keys list on top of the tab page, select the keys to filter the components and descriptors to be
listed, or check All box to enable all components and descriptors.
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l; Set Up List Schemes

Edit Selected List Scheme:

Available List Schemes:
Delete

v Default St

@ Element List Schemes
B, Basic

(&), Default

v

B Basic
T9/E. Default
r@ Companent/Keys
@ Descriptor/Keys
[ Zone List Schemes
& Kostenermittiuna

@ Component List Schemes |

<

Default

Duplicate...

-

TDIZL General Element List
r@ Window schedule Type 1
@ Window schedule Type 2 .0y Linked Property Objects:

wby Keys:

efault Set
|:| Kostenermittlung
I:| NewDatabase

> ArchiCAD_Library

Components Properties & Parameters List Format

? ®

Can by Types: [ an
D2 [ TICACF&A
R EE

ClE| B[ a8

Reduce Wall Quantities if an
Opening is larger than

List Fills and Objects Included In:

~|

All Elements |

| Floor Plans
...by Layers: All ~ | .by Stories:
M <@ [a] ARCHICAD Layer Roof
[ << - Hidden [ Gallery
[ <&> 2D Drafting - General [4 Ground Floor
[ <> 2D Drafting - Hotspot Foundation
[ <& Annotation - General
[ <Z> Annotation - Label v

Cancel

[ an

Properties & Parameters Tab Page

The Master Property Controls and Element Parameter checklists work just as they do for Element
Lists. (See relevant sections above.)

The Optional Components Data buttons determine which parts of the component will be listed
(the name and the quantity always appear).

Components Properties & Parameters |ist Format

Master Property Controls
Components:

[

Descriptors:

[

I Optional Component Data: I

Global Element Parameters:

O Element type -
O View Pen

O section Pen

O Composite Section Pens

O Line Type

O Building Material/Composite/Profile Na...
O Skin Cut Fill Names

[ 5kin Building Material Names W

Fragments:

Full Key Code

[ Key Name

||Component Co...| |

Unit || Reference Unit

1(|12(|3 (|4

I Optional Descriptor Data: I

Mame and Quantity always listed.

Fragments:

Full Key Code
1(2](3(|4

| Key Name

|| Descriptor Code | |

FullTet |

Short Text always listed.

¢ The Fragments buttons represent the four possible fragments of the Key Code string that are
separated by dots. In case of a Key Code of 004.003.002.001, Fragment 3 will return the string
‘002’, as this is the 3rd fragment of the Key Code.

Zone Lists

For a Zone List, the Set Up List Schemes dialog box changes accordingly.

Many of the controls are similar to those used for Element Lists.

See relevant sections above.
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Zones Tab Page

The first tab on top of the Setup List Schemes dialog box opens the Zones tab page.

& Set Up List Schemes

Edit Selected List Scheme:

Rooms/Stories

<@ Annotation - Structure

@@ Rooms/Zone Categories
v [ <& Annotation - Text v

&l Kostenermittiuna
£ >

Cancel

Available List Schemes: Duplicate...
Delete | Create... VI i Zones | Properties & Parameters FRelated Elements  List Format
r@ General Element List ~ ..by Categories: AII ..by Zone Number field:
r@ Window schedule Type 1 Generic rooa [ skip if it is empty
@ Window schedule Type 2 0 GRQSS A_REA . - P
: 1 Residential and Recreation ™ (st if it
A Iﬁ Component List Schemes 2 Office =
& Basic 3 Production & Research =
r@ Default [ 4 Storage & Sales ()
5 Education & Culture P v []skip Zones with an empty ID field
r@ Component/Keys
@ Descriptor/Keys .. by Layers: All ~ | ..by Stories: AII
. [ <> [R] ARCHICAD Layer ~ ERoof
hd il List Sch
Ty Zone List Schemes H << - Hidden © Gallery
E Basic [ <5> 2D Drafting - General Ground Floor
@@ Default [ <&> 2D Drafting - Hotspot 4 Foundation
: [l <& Annatation - General
r@@ Rooms/Stories ¥ <@> Annotation - Label

Check individual boxes to filter the list by Zone categories; or check All to use all categories.

You can further filter zones using the checkboxes and options under Zone Number Field at the

upper right of the tab page.

e Skip if it is empty: Omits zones without a number
e Skip Zones with an empty ID field: Omits zones without ID numbers

Properties & Parameters Tab Page

Use the checkboxes to filter the list by Zone parameters.

Shift-click to multi-select.

Zones Properties & Parameters Rejated Elements  List Format
Keys: M an Enable Listing of Related Elements
Default Set Tpes: Clan
Kostenermittiung I:] D 1::3:;[ E D F;Ia ':@:'
MewDatabase % @ ﬁ tt _tl— n m
ArchiCAD_Library Linked Property Objects:
| Elements Linked to... Property Objects v|
Reduce Wall Quantities if A
an Opening is larger than 1.00 e
Components:
| None Vl Zone Parameters:
Descriptors: [ Zone Story Index -
[4 Zone Story Name
| Maone v| OZone Category Code
Library Parts’ Additional Parameters: LlZone Category Name
[ Zone Mame W
[an | G

The Enable Listing of Related Elements buttons define which element types in the listed zones
should be included. Selecting any of these activates the Related Elements tab page (see below).

ARCHICAD Calculation Guide

53



List Schemes and Templates

Zones Properties & Parameters Rejated Elements  List Format

Keys: AII
Default Set
Kostenermittlung
MewDatabase
ArchiCAD_Library

Enable Listing of Related Elements
Types: DAII

RIS
SCH B B

| Elements Linked to... Property Objects v|
Reduce Wall Quantities if

z

an Opening is larger than 1.00 w7

Components:
| Mone V| Zone Parameters:
Descriptars: [ Zone Story Index -

[4 Zone Story Name
| None v| OZone Category Code
Library Parts’ Additional Parameters: Ll Zane Categary Name

[ Zone Mame W
[ | m—

The Reduce Wall Quantities field and the Linked Property Objects pop-up work as they do for
Element List Schemes (see above).

Related Elements Tab Page

This tab page, available only for Zone List Schemes, is active if you previously selected any Related
Elements on the Properties and Parameters tab page (see above).

Zones  Properties & Parameterd

| Related Elementsf List Format

Keys: DAII Global Element Parameters:
Default Set O Element type ~
— . O View Pen
O] kostenermittiung O section Pen
|:| MewDatabase O Composite Section Pens
CIE] Archicap_Library HlLine Type

O Building Material/Composite/Profile Na...
O Skin Cut Fill Names
[ 5kin Building Material Names

O Cut Fill Pen W
Components: Extra Parameters of the Selected Types:
| Mone v| 03D Resolution of a Curved Wall ~

O Direction of the Wall

O start Thickness of the Wall

O End Thickness of the Wall

O'wall Skin Thickness on the Qutside Face
O'wall Skin Thickness on the Inside Face

O wall Insulation Skin Thickness W

Descriptors:

| Mone -

Library Parts’ Additional Parameters

Zone listing is not restricted to the geometry of zones. It also involves the construction elements
contained in zones, specifically the surrounding walls, columns, freestanding walls, doors, windows
and other objects within Zone spaces.

The controls of the Related Elements page allow you to customize the settings by which the
elements associated with a zone or multiple zones are calculated in the zone report. The element
types to be considered in calculations are selected in the Properties & Parameters tab page.

The filters of the Related Elements tab page are identical to those of the Properties & Parameters
tab page of Element type lists.
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Using the Format Wizard/Format
Assistant

In the Setup List Schemes dialog box, make the List Format tab active and make sure that the
Graphic Template option is chosen. Select a list scheme from the left-hand tree structure, then click
the Start Format Wizard (Windows) or Start Format Assistant (Mac) button.

This opens a complex dialog box that allows you to rename, delete, duplicate and customize
templates.

& Set Up List Schemes ? X
Edit Selected List Scheme: General Element List
Available List Schemes: Duplicate...
Delete Elements Properties & Parameters List Format
v Default Set & O Text List (® Graphic [ start Format wizard... |
A T Element List Schemes
% Basic Template: |General element list [Jinclude in List Scheme
@ Default Version: 1.10 General element list layout Choose Template...
r@ General Element List List on separate level
Use for G ing & Total
r@ ‘Window schedule Type 1 e ota .
E‘ ) Farameter: Use & Define Custom Headers:
@ Window schedule Type 2 o1 Element type O ~
A & Component List Schemes 02 * Story Name / Viewpoint Name Oa
5 Basic 03 * Layer Name Oa
r@ Default 04 * UserlD O
r@ Component/Keys 05 * Library Part Name O
@ Descriptor/Keys 06 + Thickness/Size O
T Zone List Schemes o7 $ Height Oa
&l Kostenermittiuna &7 08 + Surface Area O v
£ > —

Cancel OK

Note: The Wizard/Assistant does not work on external template files, only with embedded

layout sections that are stored in binary format, in the program itself, in an ARCHICAD project

(.plIn, .pla) file, or in the Preferences file.
When you quit the Wizard and return to the Setup List Schemes dialog box, you will notice that the
name of the previously created Layout is shown in the Template: field, and the include in List
Scheme checkbox is enabled. This means that a reference to this layout will be stored in the List
Scheme file in the library, but the Layout itself will be saved within the project (.pln, .pla) or in the
Preferences file. If you disable the checkbox, the Layout can be saved as an external template text
file in the library, but in this case it will no longer be available from within the Wizard.

Note: New & Reset deletes all custom Layouts; only factory default Layouts will be available.

See Templates.

ARCHICAD Calculation Guide 55



Using the Format Wizard/Format Assistant

Format Wizard: Layout Tab Page

i Format Wizard ? *
Layout Content Fields
Layout Mames:
Layout Type: Single Column e
General element list0
Width: 270.0
Height: 193.0
Header...
Footer...
Background...
Unit in the selected layout: mm.
Duplicate... Rename... Delete Details...
o'l General element list layout
Preview... < Back Mext = Cancel

The Format Assistant/Wizard dialog box opens with the Layout tab page by default.
Select a Graphic Template to edit from the Layout Names list at the left-hand side of the tab page.

¢ Inthe list, factory default and locked templates appear in gray. Default templates are wired into
the ARCHICAD resource code and cannot be edited; only the details can be viewed in the Format
Assistant/Wizard.

e Editable layouts appear in black print and can be customized individually.

All existing layouts can be duplicated, including default and locked ones. The copies are freely
editable.

Duplicate, rename and delete selected layouts using the corresponding buttons below the Layout
Names list at the bottom left of the Layout tab page.

Note: To edit the template of a locked list scheme, first unlock it in the Setup List Schemes
dialog.

Layout Type

Define the layout type of the selected graphic template from the Layout Type pop-up list page.

e To order pages vertically, choose Single Column.
e To organize pages in a grid system, choose Tiled.
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Layout Details

Click Details to define individual settings for either option (Single Column or Tiled).

For a Single Column list:

Single Column e

Layout Type:

[ Details ? *

Comment:

General element list layout |
Background...

Lmm.

Delete Details...

e Define the Line Gap between two consecutive list items
e Choose the Layout Scale to be used when pasting the list into ARCHICAD views
Note: The Auto option will use the current scale of the Floor Plan.

You can type any remark in the Comment field. The comment appears in the Info field of the

Format Assistant/Wizard.
For a Tiled list:

e Use the Grid fields to define the number of horizontal and vertical cells, then define the gaps
between them in both directions.

e Use the Cell Sequence buttons to organize the direction that the cells should follow each other.

.; Details

Grid:

Line Gap:

Comment:

Gap between cells:

Layout Scale:

?
X
= —
oo B0
Cell Sequence
270.0
10.0 mm
193.0
00 |nm
Footer.

General element list layout

| Background...

Cancel Details...
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Edit Page Item

Clicking any of the Header, Footer or Background buttons opens the Edit Page Item dialog box
where you can edit these settings. It is possible to place a Header and/or Footer on each page or
only on the first page. The first page Header and/or Footer can be different from the rest.

[ Edit Page Item

Header

Footer
Background

Header on the first page
Footer on the first page

Rows:

Field to Edit:

Text Field:

2 Columns:

#usertext[5]

Insert >

Element type e

Insert...

e

Total Width:
Total Height:
O width:

Height:

Offset:

All values in mm

? X

Default Text Format...

Picture...

|265.D

|14.D

| 25,4

|?.D

|D.D

|D.D

Text Format...
Borders...

Cancel

Choose the Page Item you wish to modify from the Edit pop-up list at the upper left of the dialog
box. Predefined formats are available from the Record Type pop-up.

Define the Page Item size by typing the desired values in the Total Width and Total Height fields.
Organize the selected Page Item into Fields using the Rows and Columns fields.

Edit the default text type of the selected page item in the Default Text Format dialog box. Use the
Insert text pop-up to define how the text will be cropped if it does not fit in the cell.

Edit:

| Header

| | Default Text Format... | |

Record Type: [ Default Text Format ? K
| Empty Header (landscape)] v|
Tok | Arial Western v|
Rows: -_ Columns: 1 Tot
™ D Mg[zA_Jmm
2 i - - Italic
Field to Edit: = el
[ underline "-25U L
Text Field: — __
Insert text... ==
|As is v|
Insert == Element type e SETEE
Al

Insert...

Bt |

Cancel

Borders...

OK

Click Picture to import a bitmap image into the layout of the edited page item. The bitmaps can be
external image files from any of the active Libraries, ARCHICAD object symbol drawings generated
by Property Objects, or Preview Pictures of ARCHICAD Library Parts in the active Libraries.
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‘ Picture

Use Picture

Library Part Preview e

Change...

(lalalsl

8(/nsls
8

Figure Mame: iBooksheIfm Zc.gsm_

T X

Picture Position & 5Scale
@ Auto

O Scale Ratio:
14 | 100000 |,

000 |:1,

0.00

&

o

All values in mm.

e
e

-4

Anchor Point:

Cancel

Use these controls in the Edit Page Item dialog box to further define the item (e.g. header, footer).

[ Edit Page Item ? X
Edit:
| Header V| Default Text Format...
Record Type: Picture...
Corporate Header w
Total Width: |1?5.0 |
| Rows: 1 Columns: 3 ITotaI Height: |12.5 |
Field to Edit: 1 [ Width: |zo.o |
Text Field: Height: |0.0 |
Page #page
Offset: |155.0 |
[oo |
Insert == Element type ~ Text Format... I
All values in mm.
Insert... V| Borders... I

Use the Field to Edit counters to define which field you wish to modify. The first counter is for

the column, the second is for the row.

Define the size and position of the selected field using the Width, Height and Offset fields.
To set a non-default text type for the field, click the Text Format button.

Click the Borders button to set Field borders.

E Field Borders

Borders

Top Left
[ Bottom  [“]Right
u L

Preview

Cancel
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Define the contents of Text Fields: Choose an item from the pop-up and click the Insert >> button.
Click the Insert pop-up below to add globally defined data.

[ Edit Page Item

Edit:

| Header v|

Record Type:

| Custom v|

Total

Rows: Columns: Total
Text Field:

Field to Edit: [ 1o Page #pages
ITe)d:FieId: I

Page #page#

Insert == Element type e

r—
Insert == Element type £
Element type
Insert... Story Mame / Viewpoint Name Page Mumber
Layer Mame Date
User ID Time
Project Name
W—Thickness.fsize
= Height Layout Scale
Preview... Surface Area Drawing Scale
Volume Total Mumber

Format Wizard: Content Tab Page

Use the Content tab page of the Format Assistant/Wizard to define how to display the parameters
in the list.

i Format Wizard ? *

Layout| Fields

Parameters
[¥] 07 Height ~  Edit Record:
[¥] 08 Surface Area
09 Volume Pagebreak:
« [#] Display Headlines by...
I s il Group selected parameters
[¥] 01 Element type
[w] 02 Story Mame / Viewpoint Name
[#] 03 Layer Name
[¥] 04 User ID
[¥] 05 Library Part Name
[¥] 06 Thickness/Size
[¥] 07 Height
[¥] 08 Surface Area
09 Volume

Ungroup selected parameters

QI General element list layout

Preview... < Back Mext = Cancel

The Parameters list here is the same as those in the Properties & Parameters tab page of the Setup
List Schemes dialog box.
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Select the Parameters you want to use to generate Records. The Parameters are listed according to

Record type, of which there are three:

.; Format Wizard

Layout Content  Fields

Parameters

01 Element type

03 Layer Name

[¥] 04 User ID

05 Library Part Name
06 Thickness/Size

[ 07 Height

08 Surface Area

[¥] 09 volume

o . Records to display one-by-one

02 Story Mame / Viewpoint Mame

Calculate Totals/Subtotals by ..
—

Display Headlines by...

e Records to display one by one
e Calculate Totals/Subtotals by...
e Display headlines by....

Check the Parameter boxes to make the selection.

Group a selection of checked parameters by clicking the Group selected parameters button to the

right of the Parameters list field.

.; Format Wizard

Layout Content  Fields

Parameters

02 Story Name / Viewpoint Mame

- i -hy-one ~  Edit Record:
« [v] Group of records 01-09

] 01 Element type Pagebreak:

03 Layer Name
04 User ID

Group selected parameters |

05 Library Part Name
[#] 06 Thickness/Size
107 Height
08 Surface Area
09 Volume
« [v] Calculate Totals/Subtotals by ...
[¥] Grand Total
[¥] 01 Element type

Ungroup selected parameters

w102 Storv Mame / Viewpoint Name e
o'l General element list layout
Preview... < Back Mext =

The result is identical with the Group & Count function of Text Lists.

Choose the desired option from the Pagebreak pop-up to properly organize records on pages.
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Format Wizard: Fields Tab Page

The Fields tab page is very similar to the Edit Page Item dialog box described above.

See Edit Page Item.

m Format Wizard

Parameter & Record:

Layout Content

Record: Element type w

Record Type:
| Custom v|

Total Width:
Rows: Columns: Total Height:
Field to Edit: 10l 1 | O width:
Text Field: Height:

Offset:

| Insert...

~ |

w | | Element type

All values in mm.

| Insert...

~ |

Preview...

0' General element list layout

< Back Mext >

Apply Header Format
Default Text Format...

Picture...

|D.D

|D.D

|D.D

|D.D

|D.D

|D.D

Text Format...

Borders...

Cancel

The Parameters selected in the Content tab page appear in the Parameter & Record pop-up list.

You can select a predefined Record type for all parameters or you can edit existing ones. Predefined
types are available from the Record Type pop-up. When editing predefined Record types, the pop-

up will switch to Custom.
See also Step By Step Examples.
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Step By Step Examples

A: Calculation Examples

Example 1: Zones with all included object types summarized (subtotal by
zones)

1. Open the Set up List Schemes the dialog box.
2. Duplicate one of the Zone list schemes and name it, e.g., “Objects by Zones”.

[ Duplicate List Scheme ? X

Mame: |Objects byZones| | | oK

Cancel

3. In the first tab page (Zones), be sure to set filters appropriately: if you want to list all zones,
check all stories, all zone categories, etc.

4. Inthe second tab page (Properties & Parameters):

¢ set None in the Components, Descriptors and Library Part’s Additional Parameters pop-up
menus;

e enable objects (click the chair icon) in the Enable Listing of Related Elements box;

e set All Elements in the Linked Property Objects pop-up menu;

* check Zone Name and Zone Number in the Zone Parameters list.

Zones Properties & Parameters Related Elements List Format

Keys: Clan Enable Listing of Related Elements
(&) pefauit set Types: Clan
|:| Kostenermittiung |:] D = E Ij IE ':(‘;j):'
|:| MNewDatabase % @ ﬁ 11 _tl— i:t m
ArchiCAD_Library Linked Property Objects:
[ Al Elements ]
Reduce Wall Quantities if
an Opening is larger than me,
Components:
| Nane V| Zone Parameters:
Descriptors: O Zone Story Name -

O Zone Category Code

| None v| OZone Category Mame
Library Parts’ Additional Parameters: [1Zone Name

¥l Zone Number v
| Mone V| -

5. Inthe third tab page (Related Elements):

e Set None in the Components, Descriptors and Library Part’s Additional Parameters pop-up
menus;

e Check Library Part Name in the Global Element Parameter list.
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Zones  Properties & Parameters

Keys:
OE]J Defauit set
D Kostenermittlung
D MewDatabase
ArchiCAD_Library

Components:

Related Elements [jst Format

Jan

Global Element Parameters:

O skin/Component Area -
O Thickness/Size

O Composite Thicknesses

[ Height

O Associated Property Object

O Property Object Part(s) by Criteria

O Base Elevation

O Associative Label W

Extra Parameters of the Selected Types:

|None

Descriptors:

|None

Library Parts’ Additional Parameters:

|None

In the fourth tab page (List Format):
e Select Text List;

e Set Group & Count Identical in the Elements pop-up menu; be make sure that the following

parameter list is at the bottom:

Zones

(®) Text List

Properties & Parameters Related Elements List Format

O Graphic Template

Elements:

| Group & Count Identical

v| Separators: 4] show Column Headers

Components: | Quantity only

Column: D

> |

Descriptors: | Short Text anly v| Row: |:| Mark for ‘None” |I|
Farameter: Use & Define Custom Headers:
o Zone Story Name [ | ~
02 * Zone Category Code Oa
03 * Zone Category Name Oa
04 + Zone Mumber O
05 + Zone Name O
06 = Zone Floor Level O
o7 + Zone Height Oa
08 + Measured Area O w

7. Click OK and choose the saved Object by Zones list scheme in Zone Lists. You will get a list

something like this:

% [Zones / Objects by Zones] x
tegory Code | Zone Category Name | Zone Number | Zone Name | Zone Floor Lewvel | Zone Height | Measured Area | Library Part Name
| | | | | | |
| Education & Culture | 05 | Gallery | -0.10 | 20 | 25.78 | S
| Education & Culture | 01 | Exhibition space | -0.10 | 2.76 | 63.30 | /S
I/ (s I/ [ [ [ | Chair Layout 18
I/ (s I/ (I [ 17/ | Piano 18
I/ (s I/ I/ [ 17 | Piano Bench 18
I/ (s I/ I/ I/ 17/ | Stair 1
| Technical Equipment | 03 | WC | -0.10 | 2.54 | 2.04 |/
I/ I/ I/ [ [ I/ | WC 12
| Technical Equipment | 04 | Washroom | -0.10 | 2.54 | 3.83 |/
[ [ [ [ [ [ | Basin 18
| Communication & Access | 02 | Entrance | -0.10 | 2.54 | T.74 | S
| | | | | | |
| | | | | | 102.69 |

Example 2: Grand total of object types for the entire project

1. Open Set up List Schemes.

2.
3.
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Duplicate one of the Element list schemes and name it, e.g., “Objects total”.

In the first tab page (Elements), be sure to set filters appropriately, i.e., check Objects (chair
icon) under “by Types”, check all stories, etc.
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4. Inthe second tab page (Properties & Parameters):

e set None in the Components, Descriptors and Library Part’s Additional Parameters pop-up
menus;

e check Library Part Name in the Global Element Parameter list.

Elements Properties & Parameters [jst Format

Keys: DAII Global Element Parameters:
OEJ pefaut set O Volume "
. O Skin Volumes
D- Kostenermittiung [ skin/Component Area
|:| MewDatabase O Thickness/Size
— . . O Composite Thicknesses
ArchiCAD_Library O Reight
[ Library Part Mame
O Associated Property Object
O Property Object Part(s) by Criteria W
Components: Extra Parameters of the Selected Types:
| Mone v| O Morph Surface/Solid [on/off]

Descriptars: O Morph Cast Shadow [on/off)
escriptars: O Morph Receive Shadow [on/off]

V| O Morph Floor Plan Perimeter

|None

Library Parts’ Additional Parameters:

| Mone v|

5. In the third tab-page (List Format):

e select Text List;

e set Group & Count Identical in the Elements pop-up menu;

6. Click OK and choose the Objects total list scheme in Element Lists. You will get a list showing the
grand total for each object type:

IE|[O. Ground Floor]
| Library Part Name

[E] (Elements / Objects total] x

Basin 18
Ceiling Lamp 18
Chair Layout 18
Deciduous Trees
Pendant Lamp 18
Fiano 18

Fiano Bench 18
Rail Wired 18
Shrubs 18

Stair 1

Iree Flan 18
WC 18

R e el N

Example 3: Zones with all included object types summarized (subtotal by
zones) and the total number of each object type (grand total)

This example describes a complete listing environment that produces the result of the previous two
list schemes within one list

Phase 1: Create the “Object Counter” Property Object

1. Use the New Properties command to open a blank Library Part Window.
2. Click Properties to open the Property Script window.

3. Copy the following two lines into the Property script:

dummy = REQUEST (“Name_of_Listed”, “”, name)

COMPONENT name, 1, “”, 1, name

See the “GDL Reference Guide” in ARCHICAD Help.
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4. Save the Property Object as, e.g., “Object Counter”.

Note: This object will generate a separate column for the Quantity (number) of each object type
(name)

Phase 2: Link “Object Counter” to the objects

Alternative 1: through individual link
1. Select all objects to be included in the list.
2. Open the Object Settings dialog box.

3. Go to the Listing Panel.

Note: This panel is not visible by default. To enable it in any construction element’s settings, go
to Options > Work Environment > Tool Settings Dialog Boxes.

4. If checked, uncheck the Link Property Objects By Criteria box, and check the Individually box
below.

5. The Link Property Objects dialog box opens.

Link Property Objects ? »
perty Obj

Choose Manually Search by Keywords

Available Property Objects in | all loaded Libraries v|

Drawing ~
cwall12 20
cwall1120
cwall10 20
cwallog 20
Cwallos 20
B cwanng 20 v

¥ Property Object Preview

Cancel

0-, Confirm your selection by clicking Link, or click Cancel to skip linking any Property
W' (Object.

To manage Property Objects, use the commands of the "Calculate” theme, [To customize your
interface to show these commands, use Options =Waork Environment > Menus.)

6. Select “Object Counter” in the list and click Link (make sure that the “Object Counter” is under
the checkbox as you return to the Object Settings dialog box).

7. Click OK to establish the link.
Note: Any Objects placed afterwards will have to be linked individually.
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Alternative 2: through dynamic link by criteria

1. Usethe Link Properties to Criteria command.

Link Property Objects to Criteria EI (=) @

Show Links in: ArchiCAD_Library V|

@ Enable Property Cbjects of all links

Mew Link Delet
e elete OUSE maore specific Criteria only
Edit Criteria... Link Property Object...
If an element matches these criteria... ~..use this Property Object
Type Fill Compaosite Width/5ize Object Name
! Common Brick B - 190 WPOOFmas 20.g...
J . Stud Partition N Cwall12 20.gsm
- - - PROPWindow 20...
- | . . . FROPDoor 20.gsm
L |2 PrROPabject 20.g...

SPO2FO0 20.gsm

Structural Concrete - I
Flat Roof - ] CRoof01 20.gsm

2. Select a Database Set in the Show Links in pop-up menu.

Click New Link, then click Edit Criteria, the Criteria Selector opens up.

4. Set the Find Elements: pop-up menu to Of Type>>, and select Object (chair icon) in the pop-up

@ N oW

palette on the right.

Criteria Selector n
Find Elements: [F2 objeat v
Fewer Choices
More Choices 1.7

Apply

Click Apply and return to the Link Property Objects to Criteria dialog box.
Close the dialog box and save the criteria when prompted.

Select all objects to be included in the list.

Open the Object Settings dialog box. Go to the Listing Panel.

Note: This panel is not visible by default. To enable it in any construction element’s settings, go
to Options > Work Environment > Tool Settings Dialog Boxes.

If checked, uncheck the Individually box and check the Link Property Objects by Criteria box.

Note: If you have other existing links for objects in the list, they may be in conflict with these
criteria for a particular object. Additional links may be valid, or more specific links can be applied
instead of this link.
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Phase 3: Setting up the List Scheme

1. Follow steps 1 to 6 from Example 1 or duplicate the existing “Objects by Zones” list scheme and
name it, e.g., “Objects by Zones + Total”.

2. Inthe third (Related Elements) tab page:

e set Object Specific tems Only in the Components pop-up menu.
e be sure to check All above the Keys list.
3. Inthe fourth (List Format) tab page:

e be sure that the following parameter list is at the bottom:

Zones Properties & Parameters Related Elements List Format

L @ Text List ) Graphic Template
Elements: | Group & Count Identical v| Separators: [] show Column Headers
Components: |QUMMWOHW v| Columr: []

- Row: Mark for ‘None”
Descriptors: | Shaort Text only v| D E

Farameter: Use & Define Custom Headers:

o Zone Mumber [ |
02 + Zone Name O

03
04

* Library Part Name

Local component(s)

4. Click OK and choose the previously saved List Scheme from Zone Lists.

IE|[O. Ground Floor] I‘%’I [Zones / Objects by Zones + Total] x®
| Zone Number | Zone Name | Library Part Name
| | |

1] 01 | Exhibition space | /
117 |7 | Chair Layout 18
117 (v | Piano 18
117 (v | Pianoc Bench 18
117 (v | Stair 1
1] 02 | Entrance (v
11 03 | WC (v
117 (v | WC 18
1] 04 | Washroom (v
117 (v | Basin 18
11 05 | Gallery (v
| | |
| | |

B: Graphic Template Setup Example

1. Choose the New Properties command. Save the Property Object to the Property Data folder in
your library. Name it for example “drawing”.

2. Create the new parameters X and Y.
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E[ﬁ. Ground Floor] [Drawing]

MNew Delete

=l

Display Variable

x  [Eluntitied-1]

al
Type Mame Value
&y picture position ¥ 3000.00

: X
EXEEUl

Eilp\cture position ¥ IEDDD‘DEl

Ee¢ oo

Details
Migration
Components
Descriptors
Scripts
Master
2D
Properties
Parameter
Interface

20 Symbol
Preview Picture

Oono oooon

2D View

3. In the Properties script window, type “DRAWING”.

4. Inthe 2D script window, type:

DRAWING3 7, 270, 2
ADD2 x,y
DRAWING2

See the “GDL Reference Guide” in ARCHICAD Help.

5. Save the Property Object.

6. Select objects on the Floor Plan and assign this Property Object to them. In the Object Settings
dialog box, on the Listing Panel, uncheck the by Criteria checkbox and check the Individually

checkbox.

Note: The Listing Panel is not visible by default. To enable it in any construction element’s
settings, go to Options > Work Environment > Tool Settings Dialog Boxes.

7. Then select the Property Object you have just created (drawing).

Link Property Objects
perty Ubj

Choose Manually Search by Keywords

Available Property Objects in | all loaded Libraries

Object Counter
cwall12 20
cwall1120
cwall10 20
cwallog 20
Cwallos 20
B cwanng 20

¥ Property Object Preview

LWV object.

| oawng [

0-, Confirm your selection by clicking Link, or click Cancel to skip linking any Property

To manage Property Objects, use the commands of the "Calculate” theme, [To customize your
interface to show these commands, use Options =Waork Environment > Menus.)

Cancel
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8. Open the Set up List Schemes dialog box. Select the General Element List scheme and duplicate
it (US users: select Element List Set and duplicate it). Name it “My Object Inventory”.

9. On the Elements tab page, choose Objects as the only element type to be included in the list.

Elements Properties & Parameters List Format

by Types: DAII |:| Skip Elements without an associative label
= ' CA 9| A& [j [ skip Elements with an empty ID field
= Red ‘Wall Quantities if
B Ol A | (] Sise a Quantties it an

..oy Linked Property Objects: List Fills and Objects Included In:

| All Elements v| | Floor Plans v|
..by Layers: All ~ | ..by Stories: 1 an
[ <> [R] ARCHICAD Layer ~ [FRoof

<< - Hidden [ Gallery

[# <&> 2D Drafting - General [4 Ground Floor

[ <&> 2D Drafting - Hotspot 4 Foundation

[ <&> Annotation - General

[ <2> Annotation - Label

[ <& Annotation - Structure

[ <&> Annotation - Text W

10. On the Properties and Parameters tab page, select None in the Components and Descriptors
pop-up lists and check the following parameters on the parameter list:

e UserID

e Thickness/Size

e Height

e Library Part name
[ ]

Story Name/Viewpoint Name

Elements Properties & Parameters [jst Format

Ry Can Global Element Parameters:
OE]J pefauit set [ Skin Volumes ~

— . O skin/Component Area
D Kostenermittiung [ Thickness/Size

> |:| MewDatabase O Compaosite Thicknesses
— . . 4 Height

ArchiCAD_Library [ Library Part Mame
O Associated Property Object
O Property Object Part(s) by Criteria
[ Base Elevation W
Components: Extra Parameters of the Selected Types:
| Mone v|

Descriptors:

| Mone v|

Library Parts’ Additional Parameters:
| Mone v|

11. On the List Format tab page, choose Graphic Template. Then change the order of the
parameters as shown:
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Elements Properties & Parameters List Format

O Text List (® Graphic Template Start Format Wizard...
Template: |Ger1era| element list [Jinclude in List Scheme
Version:  [1.10 [General element list layout Choose Template...

List on separate level
Use for Grouping & Total
r Farameter: Use & Define Custom Headers:
User ID O
Library Part Name Oa
03 Story Mame / Viewpoint Name [ | .

oo

12. Click the Start Format Wizard/Assistant button.
13.In the appearing window, select the General Element List layout.

14. Click the Duplicate button. Name your new list layout: “#My Object Inventory”.

E Format Wizard

Layout Content Fields

Layout Mames:

Basic Element

General element list
Window schedule Type 1
Window schedule Type 2

Unit in the selected layout: mm.

Duplicate... Delete

15. Click the Header button. Select the Empty Header (landscape) Record Type.

[ Edit Page Item

Edit:

| Header v|

Record Type: Picture...

Default Text Format...

*

Empty Header (landscape) w
Total Width: | 265.0

Rows: Columns: Total Height: |1.0

Field to Edit: 1 1 = O width: |o.u

Text Field: Height: |0.0
Offset: | 0.0
| 0.0

All values in mm.
Insert... ~ Borders...

Cancel

ARCHICAD Calculation Guide

71



Step By Step Examples

16. Select Footer from the Edit pop-up menu, and then select the Empty Footer (landscape) Record

type.

[ Edit Page Item

Edit:

| Footer

~ |

Record Type:

Rows:

Empty Footer (landscape) w

Columns:

Total Width:

Total Height:

17.Select Background from the Edit pop-up menu, and enter 260 mm for the total width and 180
mm for the total height. Enter the same numbers for the width and height fields below.

[ Edit Page Item

Edit:

| Background v|

=

*

Apply Header Format

Default Text Format...

Record Type: Picture...
| Custom v|
Total Width: |260.0 |
Rows: Columns: Total Height: |1B0.0 |
Field to Edit: 1= 1 = O width: |260.0 |
Text Field: Height: |130|0 |
Offset: |0.0 |
[os |
All values in mm.
Insert... ~ Borders...

18. Click the Picture button and select None in the

Use Picture pop-up.

E Picture

Use Picture

?

*

Picture Position & Scale

@ Auto
O Scale Ratio:
1: | 100.00 0.01 1 00.00 |%

All values in mm.

++ 4
+ 1= +

L

Anchor Point:

Cancel
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19. Click the Borders button to open the Field Borders dialog box. Check all boxes to draw borders
on each side. Click OK to return to the Edit Page Item dialog box.

l Field Borders

Borders

M Top
Bottom

_u L
Offset: mm

Left
Right

Preview

Cancel

?

*

20. Select “Header on the first page” from the Edit pop-up menu, and select Empty Header

(landscape) from the Record Type pop-up list.

21. Select “Footer on the first page” from the Edit pop-up menu, and select Empty Footer

(landscape) from the Record Type pop-up list.

22.Click OK to return to the Layout tab page.

23. Click the Preview button. (Some Objects must be placed on the Floor Plan, otherwise the
preview will not display anything.) Click Done to close the window.

l List Preview

? X

Mext >

24. Go to the Content tab page and uncheck all checkboxes under the Records to display one-by-
one parameter in the Parameters list.

25. Uncheck all checkboxes under the Display Headlines by... parameter in the Parameters list.
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26.Select all the parameters under Calculate Totals/Subtotals by (except for Grand Total) and click
the Group Selected Parameters button. The result will be as shown below. The five selected
parameters will become hierarchically the members of a new group called Group of totals 01-
05.

i Format Wizard ? *

Layout Content  Fields

Parameters
[ Records to display one-by-one Edit Record:
[ calculate Totals/Subtotals by ...
« [=] Display Headlines by... Pagebreak: Mone e

[ List Headline
« [v] Group of headlines 01-05
[ 01 User ID
02 Library Part Name
03 Story Name / Viewpoint Mame
[#] 04 Thickness/Size
[ 05 Height

Group selected parameters

Ungroup selected parameters

0' General element list layout

Preview... < Back Mext = Cancel

27.Go to the Fields tab page. In the Parameter & Record pop-up you have only one item: Group Of
Totals 01-05.

28. Set the total width to 260 mm, and set the total height to 100 mm.

29. Set the number of rows to 10, and the number of columns to 6.

i Format Wizard ? *

Layout Content Fields

Parameter & Record: Apply Header Format
| Group of headlines 01-05 v|
Default Text Format...
Record Type: Picture...
| Custom v|
Total Width: |260.D

Rows: Columns: EI Total Height: |1DD.D
Field to Edit: = 12 O wigtn: 423

Text Field: Height: |1D.D
Offset: |D.D
|D.D
| Insert... v| | User ID v| Text Format...
All values in mm.
| Insert... v| Borders...

0' General element list layout

Preview... < Back Mext = Cancel

30. Click the Picture button to open the Picture dialog box, and select Property Object 2D Full View
from the pop-up list.
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31.Enter 100 mm for the width and 50 mm for the height. Also enter 47.1 mm for the first
(horizontal) offset and 40 mm for the second (vertical) offset.

.; Picture

Use Picture

Prop. Object 2D Full View v|

Picture Position & Scale

@ Auto

O Scale Ratio:
1: 100,00 |, 0.01 :1, |100.00 (%

Width:

All values in mm.

i+
+ + 4

L

Anchor Point:

Cancel

32. Click OK to return to the Fields tab page of the Format Wizard/Assistant.

33. Proceed as follows: choose Row 1/Column 1, select the first parameter from the right-hand side
pop-up (User ID) then select Name from the left-hand side pop-up to be displayed in the field.
Repeat these steps with all the parameters in the list.

.; Format Wizard

Layout Content Fields

Parameter & Record:

| Group of headlines 01-05 v|

Record Type:

| Custom v|
Rows: Columns: EI
Field to Edit: 1 1B
Text Field:
£NAME[]

Insert... |v| | User ID v|
Insert...

[ ]
Value
Mumber of Instances
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34.The second row displays the actual values of the parameters. Set the Field to Edit counter to the

second row and start inserting the values. Select the parameter in the right-hand side pop-up
and then choose Insert/Value from the left side pop-up.

.; Format Wizard

Layout Content Fields

Parameter & Record:

| Group of headlines 01-05

Record Type:

| Custom

Rows: Columns: IZI'I
Field to Edit: 2 = s [

Text Field:

#VALUE[S]

Insert... [+] [ Heignt ]
Insert...

Value
Total
Mumber of Instances

Mame
Unit

< Back Mex

35.The third row displays the number of instances. Set the Field to Edit counter to the third row and
enter into the first field: “Number of Instances”. For the second field of the third row select the
first parameter at the right-hand side pop-up list and choose Insert/Number of Instances.

.; Format Wizard

Layout Content Fields

Parameter & Record:

| Group of headlines 01-05

~ |

Record Type:

| Custom

Rows: Columns: EI

Field to Edit: 3 = 5 =
Text Field:

#NUMBER[S]

Insert... [+] [ Heignt ]
Insert...

[ ]

Value

Total L

Mumber of Instances out

Mame

Unit < Back MNe

36. Click the Preview button to see the preview. (Some objects must be placed on the Floor Plan,
otherwise the preview will not display anything.) Click Done to return to the Wizard/Assistant.

37.Set the height of the letters in the Default Text Format dialog box to 4 mm and select centered
justification.
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38. For each field set the borders to be displayed on the bottom of the field. Click the Borders
button and check the Bottom checkbox.

39. The fields of the second line could be offset vertically by 2 mm so that it looks a little tidier. The
third line could be offset 5 mm vertically. Enter the offset for each field separately.

40. Click Done to finish.
41. Select Element Lists > My Object Inventory to display the list.

IE|[O. Ground Floor] [Elements / My Object Inventory] x® [Drawing]
User D Library Part Mame Story Mame [ Viewpoint Name Thickness/Size  Height
FU - 005 Chair Layout 18 Ground Floor 340 0.85
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